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Overview
Welcome to the Lathe Machining User's Guide. This guide is intended for users who need to become quickly 
familiar with the Lathe Machining Version 5 product. 

This overview provides the following information:

●     Lathe Machining in a Nutshell

●     Before Reading this Guide

●     Getting the Most Out of this Guide

●     Accessing Sample Documents

●     Conventions Used in this Guide.

Lathe Machining in a Nutshell
Lathe Machining easily defines NC programs dedicated to machining 3D cylindrical parts using 2-axis 
turning and drilling operations, for both horizontal and vertical spindle lathe machines. 

Quick tool path definition is ensured thanks to an intuitive user interface based on graphic dialog boxes. 
Tools can be easily created and integrated to tool catalogs. Tool path can be generated, simulated and 
analyzed. 
Whole manufacturing process is covered from tool path definition to NC data generation thanks to an 
integrated postprocessor execution engine. Shop floor documentation is automatically created in HTML 
format. 
Finally, associativity with Version 5 design products allows productive design change management. 

Suitable for all kinds of cylindrical machined parts, Lathe Machining fits the needs of Fabrication & Assembly 
industry, as well as all industries where lathe machining techniques are involved.  
It can be used in shop-floors as a stand-alone product for CAM-centric customers, who will particularly 
appreciate the product's ease-of-use and high level of manufacturing capabilities. 
Lathe Machining can be combined with DELMIA products for overall manufacturing process integration, 
simulation and optimization, particularly for bigger customers concerned by high quality and quick time-to-
market.

Before Reading this Guide
Before reading this guide, you should be familiar with basic Version 5 concepts such as document windows, 
standard and view toolbars. Therefore, we recommend that you read the Infrastructure User's Guide that 
describes generic capabilities common to all Version 5 products. It also describes the general layout of V5 
and the interoperability between workbenches.

You may also like to read the following complementary product guides, for which the appropriate license is 
required: 

●     NC Manufacturing Infrastructure User's Guide: explains how to use common Machining functionalities

●     Prismatic Machining User's Guide: provides useful information about axial machining operations.

Getting the Most Out of this Guide



To get the most out of this guide, we suggest that you start reading and performing the step-by-step 
Getting Started tutorial. This tutorial will show you how to produce an NC program for turning. 

Once you have finished, you should move on to the User Tasks section, which gives more complete 
information about the product's functionalities. The Reference section provides useful complementary 
information.

The Workbench Description section, which describes the commands that are specific to Lathe Machining, 
and the Customizing section, which explains how to customize settings, and the Methodology section, which 
provides useful information about recommended work methods, will also certainly prove useful.

Accessing Sample Documents
To perform the scenarios, you will be using sample documents contained in the 
doc/online/lmgug_C2/samples or doc/online/lmgug_D2/samples folder. For more information about this, 
refer to Accessing Sample Documents in the Infrastructure User's Guide.
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Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and 
understand important concepts and specifications. 

Graphic Conventions

The three categories of graphic conventions used are as follows:

●     Graphic conventions structuring the tasks

●     Graphic conventions indicating the configuration required

●     Graphic conventions used in the table of contents

Graphic Conventions Structuring the Tasks

Graphic conventions structuring the tasks are denoted as follows:

This icon... Identifies...

estimated time to accomplish a task

a target of a task

the prerequisites

the start of the scenario

a tip

a warning

information

basic concepts

methodology

reference information

information regarding settings, customization, etc.

the end of a task

functionalities that are new or enhanced with this release

allows you to switch back to the full-window viewing mode



Graphic Conventions Indicating the Configuration Required 

Graphic conventions indicating the configuration required are denoted as follows:

This icon... Indicates functions that are... 

specific to the P1 configuration

specific to the P2 configuration

specific to the P3 configuration

Graphic Conventions Used in the Table of Contents

Graphic conventions used in the table of contents are denoted as follows:

This icon... Gives access to...

Site Map

Split View Mode

What's New?

Overview

Getting Started

Basic Tasks

User Tasks or Advanced Tasks

Interoperability

Workbench Description

Customizing

Administration Tasks

Reference

Methodology

Frequently Asked Questions

Glossary

Index



Text Conventions

The following text conventions are used:

●     The titles of CATIA, ENOVIA and DELMIA documents appear in this manner throughout the text.

●     File -> New identifies the commands to be used.

●     Enhancements are identified by a blue-colored background on the text.

How to Use the Mouse

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button... Whenever you read...

 
●     Select (menus, commands, geometry in graphics area, ...)

●     Click (icons, dialog box buttons, tabs, selection of a location in the document 
window, ...)

●     Double-click

●     Shift-click

●     Ctrl-click

●     Check (check boxes)

●     Drag

●     Drag and drop (icons onto objects, objects onto objects)

●     Drag

●     Move

●     Right-click (to select contextual menu)



What's New?

Enhanced Functionalities

Support turning operations on milling center machines
For a lathe center machine, the turning plane is defined once at part operation level. To provide 
turning operations on a milling center machine with facing heads, it is now possible to select several 
turning machining planes at machining operation level.

Enhancements brought by the NC Manufacturing Infrastructure
This product benefits from enhancements to the infrastructure's general functions (NC program 
review, material removal simulation, and so on). Please refer to the NC Manufacturing Infrastructure 
User's Guide for more information.

file:///E|/www/jmndocr15/Doc/online/mfgug_C2/mfgugwn.htm
file:///E|/www/jmndocr15/Doc/online/mfgug_C2/mfgugwn.htm
file:///E|/www/jmndocr15/Doc/online/mfgug_C2/mfgugwn.htm


Getting Started
Before getting into the detailed instructions for using Lathe Machining, this tutorial is intended to give you a 
feel of what you can accomplish with the product.  

It provides the following step-by-step scenario that shows you how to use some of the key functionalities. 

Open the Part to Machine
Create a Rough Turning Operation

Replay the Toolpath
Create a Groove Turning Operation

Create Profile Finish Turning Operation
Generate NC Code



Open the Part to Machine

This first task shows you how to open a part, enter the Lathe Machining workbench and make basic modifications to the Part 
Operation.

1. Select File > Open then select the Lathe01.CATPart document.

2. Select Machining > Lathe Machining from the Start menu.

The Lathe Machining workbench appears. The part is displayed in the Setup Editor window along with the manufacturing 
specification tree. 

3. Double click Part Operation.1 in the tree to display the Part Operation dialog box.

4. Click the Machine icon. The Machine Editor dialog box appears.

●     Select the Horizontal Lathe Machine icon.

●     Set the spindle axis to Z and the radial axis to X.

●     Click OK.

 Setting the spindle axis to Z defines the C-axis (that is, rotary motion about the Z-axis). This allows creation of indexed machine 
rotations for milling and drilling operations.

5. Set the tool change point in the Position tab page as shown below.

file:///E|/www/jmndocr15/Doc/online/lmgug_C2/samples/Lathe01.CATPart


6. Click OK to confirm your modifications to the Part Operation.

7. Select Manufacturing Program.1 in the tree to make it the current entity.

To insert program entities such as machining operations, tools and auxiliary commands you can either: 
●     make the program current before clicking the insert program entity command

●     click the insert program entity command then make the program current.



Create a Rough Turning Operation

This task shows you how to create a Longitudinal Rough Turning operation for machining part of the 
workpiece. 

This operation will use the tool proposed by the program, so you just need to specify the geometry 
to be machined and set some of the machining parameters.

1. Select the Rough Turning icon . 

A Rough Turning.1 entity along with a default tool is added to the program.

The Rough Turning dialog box appears directly at the Geometry tab page .

2. Click the 
red Stock 
area in the 
icon, then 
select the 
stock 
profile as 
shown. 

Click OK in 
the Edge 
Selection 
toolbar to 
end your 
selection. 

3. Click the 
red Part 
area in the 
icon, then 
select the 
part profile 
as shown. 

Click OK in 
the Edge 
Selection 
toolbar to 
end your 
selection. 



4. Select the 
Strategy 
tab page 

 and 

set the 
parameters 
as shown.

5. Click OK to create the operation.



Replay the Tool Path

This task shows you how to replay the tool path of the Roughing operation.

1. Select the 
Roughing 
operation 
in the tree 
then 
select the 
Replay 
Tool Path 

icon .

The Replay 
dialog box 
appears.

2. Choose 
the 
Continuous 
replay 
mode by 
means of 
the drop 
down icon 

 .

3. Click the  button to position the tool at the start point of the operation. 

4. Click the  button to start  the replay. The tool moves along the computed trajectory.

5. Click OK to quit the replay mode.



Create a Groove Turning Operation

This task shows you how to create a Groove Turning operation to machine part of the workpiece. 

You will specify the geometry to be machined, set some of the machining parameters and select a 
new tool.

Make sure that the Rough Turning operation is the current entity in the program.

1.
Select the Groove Turning icon . 

The Groove Turning dialog box appears directly at the Geometry page .

2. Click the red Stock area in the icon, then select the stock profile as shown.

3. Click the red Part area in the icon, then select the groove profile as shown.

4. Select the Strategy tab page  and check machining parameters.  Set the Gouging Safety 

Angle to 10 degrees.

 5.
Select the Insert Holder tab  in the Tooling page . 

●     Enter a name of the new tool (for example, Grooving Tool).

●     Double click the l2 (shank length 2) parameter in the icon, then enter 60mm in the Edit 
Parameter dialog box.

●     Set the Max cutting depth Technology parameter to 80mm.



6. Click Replay in the dialog box to visually check the operation's tool path. 

Click OK to exit the replay mode and return to the Groove Turning dialog box.

7. Click OK to create the operation.



Create a Profile Finish Turning Operation

This task shows you how to insert a Profile Finish Turning operation in the program.

1. Select the Profile Finish Turning icon . The Profile Finish Turning dialog box appears directly at 

the Geometry page .

2. Select the red part in the sensitive icon then select the part profile.

3. Select the Strategy tab page  and set the Leading Safety Angle to 0 degrees. 

4. Click Replay to replay the operation as described previously.  

Click OK to exit the replay mode and return to the Profile Finish Turning dialog box.

5. Click OK to create the operation in the program. 



Generate NC Code

This task shows you how to generate NC code from the program. An APT source file will be 
generated in this example. 

Before doing this task, double click the Part Operation entity in the tree and, in the dialog box that 
appears, click the Machine icon to access the Machine Editor dialog box. Make sure that you have 
selected a Horizontal lathe machine and that the desired NC data format is set to Axis (X, Y, Z).

1. Use the right mouse key on the Manufacturing Program.1 entity in the tree to select Generate 
NC Code Interactively. The Generate NC Output Interactively dialog box appears. 



2. Select APT as the desired NC data type.

 3. Click the Output File button to select the folder where you want the file to be saved and specify 
the name of the file.

4. Click Execute to generate the APT source file.

An extract from a typical APT source file is given below. 

$$ -----------------------------------------------------------------
$$ Generated on Wednesday, April 07, 2004 11:16:08 AM
$$ CATIA APT VERSION 1.0
$$ -----------------------------------------------------------------
$$ Manufacturing Program.1
$$ Part Operation.1
$$*CATIA0
$$ Manufacturing Program.1
$$ 1.00000 0.00000 0.00000 0.00000
$$ 0.00000 1.00000 0.00000 0.00000
$$ 0.00000 0.00000 1.00000 0.00000
PARTNO Part Operation.1
$$ OPERATION NAME : Turning Tool Change.1
$$ Start generation of : Turning Tool Change.1
$$ TOOLCHANGEBEGINNING
CUTTER/ 10.000000
TOOLNO/1,TURN,1,0,9, 5.000000,$
0.000000, 0.000000, 0.400000,MMPR, 70.000000,RPM,$
CCLW,ON, 0.000000,NOTE
TPRINT/T1 External Insert-Holder,T1 External Insert-Holder,Turning Tool$
Assembly.1
LOADTL/1,1,1
$$ TOOLCHANGEEND
$$ End of generation of : Turning Tool Change.1
$$ OPERATION NAME : Rough Turning.1
$$ Start generation of : Rough Turning.1
SWITCH/9
FEDRAT/ 0.3000,MMPR
SPINDL/ 70.0000,RPM,CCLW
GOTO / 107.08333, 0.00000, 257.00000
GOTO / 107.08333, 0.00000, 255.00000
...
FEDRAT/ 0.8000,MMPR
GOTO / 40.21213, 0.00000, 150.21213
$$ End of generation of : Rough Turning.1
$$ OPERATION NAME : Turning Tool Change.2
$$ Start generation of : Turning Tool Change.2
$$ TOOLCHANGEBEGINNING
CUTTER/ 2.400000
TOOLNO/1,TURN,1,0,9, 1.200000,$
0.000000, 0.000000, 0.400000,MMPR, 70.000000,RPM,$
CCLW,ON,,NOTE
TPRINT/T3 External Groove Insert-Holder,T3 External Groove Insert-Holde$
r,Turning Tool Assembly.1_1
LOADTL/1,1,1
$$ TOOLCHANGEEND
$$ End of generation of : Turning Tool Change.2
$$ OPERATION NAME : Groove Turning.1
$$ Start generation of : Groove Turning.1
SWITCH/9
FEDRAT/ 0.3000,MMPR
SPINDL/ 70.0000,RPM,CCLW
GOTO / 108.20000, 0.00000, 96.70000



GOTO / 106.20000, 0.00000, 96.70000
...
RAPID
GOTO / 108.20000, 0.00000, 57.91213
$$ End of generation of : Groove Turning.1
$$ OPERATION NAME : Turning Tool Change.3
$$ Start generation of : Turning Tool Change.3
$$ TOOLCHANGEBEGINNING
CUTTER/ 10.000000
TOOLNO/1,TURN,1,0,9, 5.000000,$
0.000000, 0.000000, 0.400000,MMPR, 70.000000,RPM,$
CCLW,ON, 0.000000,NOTE
TPRINT/T1 External Insert-Holder,T1 External Insert-Holder,Turning Tool$
Assembly.1
LOADTL/1,1,1
$$ TOOLCHANGEEND
$$ End of generation of : Turning Tool Change.3
$$ OPERATION NAME : Profile Finish Turning.1
$$ Start generation of : Profile Finish Turning.1
SWITCH/9
FEDRAT/ 0.3000,MMPR
SPINDL/ 70.0000,RPM,CCLW
GOTO / -2.00000, 0.00000, 225.00000
GOTO / 0.00000, 0.00000, 225.00000
...
GOTO / 40.00000, 0.00000, 145.00000
FEDRAT/ 0.8000,MMPR
GOTO / 40.21213, 0.00000, 144.78787
$$ End of generation of : Profile Finish Turning.1
FINI



User Tasks
The user tasks you will perform with Lathe Machining involve creating, editing and managing machining 
operations and other Machining entities.

Turning Operations
Axial Machining Operations

Auxiliary Operations
Part Operations, Manufacturing Programs and Machining Processes

Machining Resources and Other Entities
Verification, Simulation and NC Output



Turning Operations
The tasks in this section show you how to create turning operations in your manufacturing program.

Create a Rough Turning operation:
Select the Rough Turning icon and choose the desired roughing mode. You can then select the 
part and stock geometry and specify the tool to be used. Specify machining parameters, feeds 
and speeds, and NC macros as needed. 

Basic tasks illustrate the following roughing modes: 

●     Longitudinal

●     Face

●     Parallel Contours.

Create a Recess Turning operation:
Select the Recess Turning icon and choose the desired recessing mode. You can then select the 
part and stock geometry and specify the tool to be used. Specify machining parameters, feeds 
and speeds, and NC macros as needed.
Create a Groove Turning operation:
Select the Groove Turning icon then select the part and stock geometry and specify the tool to 
be used. Specify machining parameters, feeds and speeds, and NC macros as needed.
Create a Profile Finish Turning operation:
Select the Profile Finish Turning icon then select the part profile and specify the tool to be used. 
Specify machining parameters, feeds and speeds, and NC macros as needed.
Create a Groove Finish Turning operation:
Select the Groove Finish Turning icon then select the part geometry and specify the tool to be 
used. Specify machining parameters, feeds and speeds, and NC macros as needed.
Create a Ramp Rough Turning operation.
Select the Ramp Rough Turning icon then select the part and stock geometry and specify the 
tool to be used. Specify machining parameters, feeds and speeds, and NC macros as needed.
Create a Ramp Recess Turning operation.
Select the Ramp Recess Turning icon then select the part and stock geometry and specify the 
tool to be used. Specify machining parameters, feeds and speeds, and NC macros as needed.
Create a Thread Turning operation:
Select the Thread Turning icon and choose the desired thread type. You can then select the part 
geometry and specify the tool to be used. Specify machining parameters, feeds and speeds, 
and NC macros as needed.
Create a Sequential Turning operation:
Create and manage a sequence of basic Go Standard, Go-Go, Go InDirv, Go Delta, and Follow 
tool motions in a single operation.

 Turning on a Milling Center:
Create turning operations to machine large diameter holes on a milling center machine 
equipped with a facing head and rotary table. 
Manage Local Information: 
Assign local feedrates and local offsets to Lathe Profile Finishing and Groove Finishing 
operations.
Update Input Stock: choose to either update the stock automatically by setting an option on the 
Part Operation or update the stock manually for each lathe operation or axial machining 
operation along the spindle axis.



Create a Longitudinal Rough Turning Operation

This task illustrates how to create a Longitudinal Rough Turning operation in the program.  

To create the operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Lathe01.CATPart document, then select Machining > Lathe Machining from the Start menu. Make the 
Manufacturing Program current in the specification tree.  

1. Select the Rough Turning icon . 

A Rough Turning entity along with a default tool is 
added to the program.

The Rough Turning dialog box appears directly at the 

Geometry tab page .  

This tab page includes a sensitive icon to help you 
specify the geometry to be machined. 

The part and stock of the icon are colored red indicating 
that this geometry is required. All other geometry is 
optional. 

2. Click the red part in the icon then select the desired part profile in the 3D window.

The Edge Selection toolbar appears to help you with contour selection.

The Automatic Linking option allows you to select a first element then the element to navigate to in order to complete the profile 
selection.

The Axial/Radial and Radial/Axial Linking options are also useful for profile selection.

  
The part of the icon is now colored green indicating that this geometry is now defined.

file:///E|/www/jmndocr15/Doc/online/lmgug_C2/samples/Lathe01.CATPart
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3. Click the red stock in the icon then select the desired stock profile in the 3D window.

4. Set Part Offset to 5mm.

5. Select the Strategy tab page  to specify the main 

machining strategy parameters: 
●     Roughing mode: Longitudinal

●     Orientation: External

●     Location: Front.

 

6. Double click Max depth of cut in the icon.  

Set this value to 15mm in the Edit Parameter dialog box 
and click OK.

Other optional parameters can be set in the Options tab 
(lead-in and so on). 

A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, 

just select the Tool tab page  to specify the tool you want to use. 

Please refer to Edit the Tool of a Lathe Operation.

7. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speeds for the operation. 

See Feeds and Speeds for Rough Turning for more information.

8. Select the Macros tab page  to specify the operation's transition paths (approach and retract motion, for 

example). 

Approach linking and retract linking motions are interruptable for this type of operation.

See Define Macros on a Lathe Operation for more information. 
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Before accepting the operation, you should check its validity by replaying the tool path. 

9. Click OK to create the operation.

file:///E|/www/jmndocr15/Doc/online/mfgug_C2/mfgugbt0401.htm


Create a Face Rough Turning Operation

This task shows how to insert a Face Rough Turning operation in the program. 

To create the operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Lathe01.CATPart document, then select Machining > Lathe Machining from the Start 
menu.  Make the Manufacturing Program current in the specification tree.  

1. Select the Rough Turning icon . 

The Rough Turning dialog box 
appears directly at the Geometry 

tab page . 

This page includes a sensitive icon 
to help you specify the geometry to 
be machined.

The part and stock in the icon are 
colored red indicating that this 
geometry is required for defining 
the operation. 

2. Click the red part in the icon then select the desired part profile in the 3D window.

The part of the icon is now colored green indicating that this geometry is now defined.

3. Click the red stock in the icon then select the desired stock profile in the 3D window.

4. Set Part Offset to 5mm.
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5. Select the Strategy tab page  

to specify the main machining 
strategy parameters: 

●     Roughing mode: Face

●     Orientation: External

●     Location: Front.

 

6. Double click Max depth of cut in 
the icon.  

Set this value to 10mm in the Edit 
Parameter dialog box and click OK.

7. In the Options tab, set the lift-off 
distance to 1.5mm. 

A tool is proposed by default when you want to create a machining operation. If the proposed 

tool is not suitable, just select the Tool tab page  to specify the tool you want to 

use. This is described in Edit the Tool of a Lathe Operation.

8. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speeds for 

the operation. See Feeds and Speeds for Rough Turning for more information.

If you want to specify approach and retract motion for the operation, select the Macros tab 

page  to specify the desired transition paths. 

Approach linking and retract linking motions are interruptable for this type of operation.

See Define Macros on a Lathe Operation for more information. 
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9. Check the validity of the operation 
by replaying the tool path.

10. Click OK to create the operation.
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Create a Parallel Contour Rough Turning 
Operation

This task shows how to insert a Parallel Contour Rough Turning operation in the program. 

To create the operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Lathe01.CATPart document, then select Machining > Lathe Machining from the Start 
menu. Make the Manufacturing Program current in the specification tree.  

1. Select the Rough Turning icon 

. 

A Rough Turning entity along with 
a default tool is added to the 
program.

The Rough Turning dialog box 
appears directly at the Geometry 

tab page . 

This tab page includes a sensitive 
icon to help you specify the 
geometry to be machined. 

The part and stock of the icon are colored red indicating that this geometry is required.

2. Click the red part in the icon, then select the desired part profile in the 3D window. 

Select the stock in the same way.
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3. Select the Strategy tab page 

 to specify the main 

machining strategy parameters: 
●     Roughing mode: Parallel 

Contour

●     Orientation: External

●     Location: Front

●     Machining direction: To head 
stock.

4. Double click Axial depth of cut 
in the icon.  

Set this value to 3mm in the Edit 
Parameter dialog box and click 
OK. 

Set Radial depth of cut to 3mm 
in the same way.

Other optional parameters can be 
set in the Options tab (lead-in and 
so on).

 When recess machining is active in Parallel Contour Rough Turning, Axial and Radial Depth of 
Cut must have suitable values to ensure a collision free toolpath. See Recommendations for 
more information.

 5. A tool is proposed by default when you want to create a machining operation. If the proposed 

tool is not suitable, just select the Tool tab page  to specify the tool you want to use. 

This is described in Edit the Tool of a Lathe Operation.

6. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speeds for 

the operation. 

See Feeds and Speeds for Rough Turning for more information.

7. If you want to specify approach and retract motion for the operation, select the Macros tab page 

 to specify the desired transition paths. 

Approach linking and retract linking motions are interruptible for this type of operation.

See Define Macros on a Lathe Operation for more information. 
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 8. Check the validity of the operation by replaying the tool path. 

9. Click OK to create the operation.
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Create a Recess Turning Operation

This task shows how to insert a Recess Turning operation in the program. 

To create the operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Lathe01.CATPart document, then select Machining > Lathe Machining from the Start 
menu. Make the Manufacturing Program current in the specification tree.  

1. Select the Recess Turning icon . 

A Recess Turning entity along with a 
default tool is added to the 
program.

The Recess Turning dialog box 
appears directly at the Geometry 

tab page .  

This tab page includes a sensitive 
icon to help you specify the 
geometry to be machined. 

 
The part and stock in the icon are colored red indicating that this geometry is required.  

2. Click the red part in the icon then select the desired part profile in the 3D window. 

Select the stock in the same way.
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3. Select the Strategy tab page  

to specify the main machining 
strategy parameters: 

●     Recessing mode: Zig zag

●     Orientation: External

●     Machining direction: To head 
stock.

4. Double click Max depth of cut in 
the icon.  

Set this value to 10mm in the Edit 
Parameter dialog box and click OK.

Other optional parameters can be 
set in the Options tab (lead-in and 
so on).

A tool is proposed by default when you want to create a machining operation. If the proposed 

tool is not suitable, just select the Tool tab page  to specify the tool you want to use. 

This is described in Edit the Tool of a Lathe Operation.

5. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speeds for 

the operation. 

See Feeds and Speeds for Recess Turning for more information.

6. If you want to specify approach and retract motion for the operation, select the Macros tab 

page  to specify the desired transition paths. 

Approach linking and retract linking motions are interruptable for this type of operation.

See Define Macros on a Lathe Operation for more information. 

Before accepting the operation, you should check its validity by replaying the tool path. 

7. Click OK to create the operation.
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Create a Groove Turning Operation

This task shows how to insert a Groove Turning operation in the program. 

To create the operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Lathe01.CATPart document, then select Machining > Lathe Machining from the Start 
menu. Make the Manufacturing Program current in the specification tree.

1. Select the Groove Turning icon 

. 

The Groove Turning dialog box 
appears directly at the Geometry 

tab page . 

This page includes a sensitive 
icon to help you specify the 
geometry to be machined.

The part and stock in the icon 
are colored red indicating that 
this geometry is required for 
defining the operation. 

2. Click the red part in the icon, 
then select the desired part 
profile in the 3D window.  

Select the stock in the same 
way.

The part and stock of the icon are now colored green indicating that this geometry is now 
defined.
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3. Select the Strategy tab page 

 to specify the main 

machining strategy parameters: 
●     Orientation: External

●     First plunge position: Center

●     Next plunges position: To 
head stock.

4. Double click Max depth of cut 
in the icon.  

Set this value to 10mm in the 
Edit Parameter dialog box and 
click OK.

Other optional parameters can 
be set in the Options tab (lead-in 
and so on).

A tool is proposed by default when you want to create a machining operation. If the 

proposed tool is not suitable, just select the Tool tab page  to specify the tool you 

want to use. 

This is described in Edit the Tool of a Lathe Operation.

5. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speeds 

for the operation.  

See Feeds and Speeds for Groove Turning for more information.

You can add approach and retract motions to the operation in the Macros tab page . 

Approach linking and retract linking motions are interruptable for this type of operation.

See Define Macros on a Lathe Operation for more information. 

6. Check the validity of the operation by replaying the tool path.

7. Click OK to create the operation.
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Create a Profile Finish Turning Operation

This task shows how to insert a Profile Finish Turning operation in the program. To create the 
operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Lathe01.CATPart document, then select Machining > Lathe Machining from the Start 
menu. Make the Manufacturing Program current in the specification tree.  

1. Select the Profile Finish Turning 

icon . 

The Profile Finish Turning dialog 
box appears directly at the 

Geometry tab page . 

This page includes a sensitive icon 
to help you specify the geometry 
to be machined.

The part in the icon is colored red 
indicating that this geometry is 
required for defining the 
operation. 

2. Click the red part in the icon, then 
select the desired part profile in 
the 3D window.

In addition to the global offsets that you can assign to the selected profile, you can also add 
local values.

Right click the geometry to be assigned the local value, and select the Add Local Information 
contextual command. A dialog box appears allowing you to assign the desired local values.

Other contextual commands are available for analyzing and resetting local information. Please 
refer to Local Information for more details. 

The part of the icon is now colored green indicating that this geometry is now defined.
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4. Select the Strategy tab page 

 to specify the general 

machining strategy parameters: 
●     Orientation: External

●     Location: Center

●     Select the Recess machining 
checkbox

●     Machining direction is set 
automatically To spindle.

Note that you can locally invert 
machining directions using Local 
Information facilities.

Other optional parameters can be 
set in the Machining, Corner 
Processing, and Local Invert tabs.

A tool is proposed by default when you want to create a machining operation. If the proposed 

tool is not suitable, just select the Tool tab page  to specify the tool you want to use. This 

is described in Edit the Tool of a Lathe Operation.

5. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speeds for the 

operation. See Feeds and Speeds for Profile Finishing for more information.

In addition to the global feedrates that you can assign for the operation, you can also add local 
feedrates to portions of the profile.  

Right click the geometry to be assigned the local value, and select the Add Local Information 
contextual command. A dialog box appears allowing you to assign the desired local values. 

Other contextual commands are available for analyzing and resetting local information.  Please 
refer to Local Information for more details. 

You can add approach and retract motions to the operation in the Macros tab page . See 

Define Macros on a Lathe Operation for an example. 

6. Check the validity of the operation by replaying the tool path.

7. Click OK to create the operation.
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Create a Groove Finish Turning Operation

This task shows how to insert a Groove Finish Turning operation in the program. To create the 
operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Lathe01.CATPart document, then select Machining > Lathe Machining from the Start 
menu. Make the Manufacturing Program current in the specification tree.  

1. Select the Lathe Groove Finish 

Turning icon . 

A Groove Finish Turning entity 
along with a default tool is 
added to the program.

The Groove Finish Turning 
dialog box appears directly at 

the Geometry tab page .  

This tab page includes a 
sensitive icon to help you 
specify the geometry to be 
machined. 

The part in the icon is colored 
red indicating that this 
geometry is required. 

2. Click the red part in the icon 
then select the desired part 
profile in the 3D window.

In addition to the global offsets that you can assign to the selected profile, you can also add 
local values.  

Right click the geometry to be assigned the local value, and select the Add Local 
Information contextual command. A dialog box appears allowing you to assign the desired 
local values.

Other contextual commands are available for analyzing and resetting local information.  
Please refer to Local Information for more details.
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3. Select the Strategy tab page 

   

to specify the main machining 
strategy parameters: 

●     Orientation: External

●     Machining direction: To 
head stock

●     Contouring for outside 
corners: Circular.

Other optional parameters can 
be set in the Machining and 
Corner Processing tabs.

A tool is proposed by default when you want to create a machining operation. If the 

proposed tool is not suitable, just select the Tool tab page  to specify the tool you 

want to use. This is described in Edit the Tool of a Lathe Operation.

4. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speeds 

for the operation. See Feeds and Speeds for Finish Grooving for more information.

In addition to the global feedrates that you can assign for the operation, you can also add 
local feedrates to portions of the profile.  

Right click the geometry to be assigned the local value, and select the Add Local 
Information contextual command. A dialog box appears allowing you to assign the desired 
local values.

Other contextual commands are available for analyzing and resetting local information. 
Please refer to Local Information for more details.

5. Select the Macros tab page  to specify the operation's transition paths (approach and 

retract motion, for example). See Define Macros on a Lathe Operation for an example. 

Before accepting the operation, you should check its validity by replaying the tool path.
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6. Click OK to create the operation.



Create a Ramp Rough Turning Operation

This task illustrates how to create a Ramp Rough Turning operation in the program.  This type of operation 
is suitable for machining hard materials using round ceramic inserts, thereby minimizing wear and cutting 
stress.

To create the operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Lathe01.CATPart document, then select Machining > Lathe Machining from the Start 
menu. Make the Manufacturing Program current in the specification tree.  

1.
Select the Ramp Rough Turning icon . 

A Ramp Rough Turning entity along with a default tool is added to the program.

The Ramp Rough Turning dialog box appears directly at the Geometry tab page .  

This tab page includes a sensitive icon to help you specify the geometry to be machined. 

The Part and Stock areas of the icon are colored red indicating that this geometry is required. All other 
geometry is optional. 

2. Click the red Part area in the icon then select the desired part profile in the 3D window.
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The Edge Selection toolbar appears to help you with contour selection.

3. Click the red Stock in the icon then select the desired stock profile in the 3D window.

The Part and Stock areas of the icon is now colored green indicating that this geometry is now defined.

4.  Set Part Offset to 5mm.

5. Select the Strategy tab page  to specify the machining strategy parameters as shown below.

6. Double click Max depth of cut in the icon.  Set this value to 15mm in the Edit Parameter dialog box 
and click OK.

Other parameters can be set in the Options and Rework tabs. 

 7. A tool is proposed by default when you want to create a machining operation. If the proposed tool is 

not suitable, just select the Tool tab page  to specify the tool you want to use. 

Please refer to Edit the Tool of a Lathe Operation.

8. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speeds for the 

operation. 

See Feeds and Speeds for Ramp Rough Turning for more information.
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9. Select the Macros tab page  to specify the operation's transition paths (approach and retract 

motion, for example). 

See Define Macros on a Lathe Operation for more information. 

Before accepting the operation, you should check its validity by replaying the tool path. 

10. Click OK to create the operation.
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Create a Ramp Recess Turning Operation

This task shows how to insert a Ramp Recess Turning operation in the program. This type of 
operation is suitable for machining hard materials using round ceramic inserts, thereby minimizing 
wear and cutting stress.

To create the operation you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Lathe01.CATPart document, then select Machining > Lathe Machining from the Start 
menu. Make the Manufacturing Program current in the specification tree.  

1.
Select the Ramp Recess Turning icon . 

A Ramp Recess Turning entity along with a default tool is added to the program.

The Ramp Recess Turning dialog box appears directly at the Geometry tab page .  

This tab page includes a sensitive icon to help you specify the geometry to be machined. 
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The Part and Stock areas in the icon are colored red indicating that this geometry is required.  

2. Click the red Part area in the icon then select the desired part profile in the 3D window. 

Select the stock in the same way.

The Part and Stock areas in the icon are now colored green indicating that the required 
geometry is selected.  

3. Select the Strategy tab page  and specify the main machining strategy parameters as 

shown below.

4. Double click Max depth of cut in the icon. Set this value to 10mm in the Edit Parameter dialog 
box and click OK.

Other parameters can be set in the Options and Rework tabs.



A tool is proposed by default when you want to create a machining operation. If the proposed 

tool is not suitable, just select the Tool tab page  to specify the tool you want to use. 

This is described in Edit the Tool of a Lathe Operation.

5. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speeds for the 

operation. 

See Feeds and Speeds for Ramp Recess Turning for more information.

6. If you want to specify approach and retract motion for the operation, select the Macros tab page 

 to specify the desired transition paths. 

See Define Macros on a Lathe Operation for more information. 

Before accepting the operation, you should check its validity by replaying the tool path. 

7. Click OK to create the operation.
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Create a Thread Turning Operation

This task shows how to insert a Thread Turning operation in the program. To create the operation 
you must define: 

●     the geometry to be machined 

●     the tool that will be used 

●     the parameters of the machining strategy 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Lathe01.CATPart document, then select Machining > Lathe Machining from the Start 
menu. Make the Manufacturing Program current in the specification tree.  

1. Select the Thread Turning icon 

. 

A Thread Turning entity along 
with a default tool is added to 
the program.

The Thread Turning dialog box 
appears directly at the 

Geometry tab page .  

This tab page includes a 
sensitive icon to help you 
specify the geometry to be 
machined. 

The part in the icon is colored 
red indicating that this 
geometry is required.

2. Click the red part in the icon 
then select the desired part 
profile in the 3D window.

3. Specify the desired length of 
threading.
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4. Select the Strategy tab page 

 to specify the main 

machining parameters that are 
organized in three tabs: 
Thread, Strategy and Options.  

Set the following values in the 
Thread tab:

●     Profile: Other

●     Orientation: External

●     Location: Front

●     Thread unit: Pitch

●     Number of threads: 1

●     Thread depth: 10mm

●     Thread pitch: 10mm.

Other optional parameters can 
be set in the Strategy and 
Options tabs.

5. If you want to generate CYCLE statements, you must select the Output CYCLE syntax 
checkbox in the Options tab and set the Syntax Used option to Yes in the NC Output 
generation dialog box. Otherwise, GOTO statements will be generated. 

You can display and edit CYCLE syntaxes by clicking the Edit Cycle command.

 6. A tool is proposed by default when you want to create a machining operation. If the 

proposed tool is not suitable, just select the Tool tab page  to specify the tool you 

want to use. 

This is described in Edit the Tool of a Lathe Operation.

7. Select the Feeds and Speeds tab page  to specify the machining spindle speed for 

threading.

Feedrates in units per minute are available for air cutting such as macro motions and path 
transitions. 
Note that RAPID feedrate can be replaced by Air Cutting feedrate in tool trajectories (except 
in macros) by selecting the corresponding checkbox.

8. Select the Macros tab page  to specify the operation's transition paths (approach and 

retract motion, for example). 

See Define Macros on a Lathe Operation for an example. 
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 9. Before accepting the operation, you should check its validity by replaying the tool path.

10. Click OK to create the operation.

Example of output

If your PP table is customized with the following statement for Thread Turning operations:

CYCLE/THREAD,%MFG_THREAD_PITCH

A typical NC data output is as follows:

CYCLE/THREAD, 10.000000

The parameters available for PP word syntaxes for this type of operation are described in 
the NC_LATHE_THREADING section of the Manufacturing Infrastructure User's Guide.
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Create a Sequential Turning Operation

This task illustrates how to create a Sequential Turning operation in the program.  

To create the operation you must define: 

●     the list of elementary motions making up the operation 

●     the tool that will be used 

●     the feedrates and spindle speeds 

●     the macros (transition paths) .

Open the Lathe01.CATPart document, then select Machining > Lathe Machining from the Start 
menu. Make the Manufacturing Program current in the specification tree.  

1. Select the Sequential Turning icon . A Sequential Turning entity along with a default tool is 

added to the program. The dialog box appears directly at the List of Motions tab page .  

The first motion must be a Go motion to a point.

2. Select the Go icon . The dialog box for defining the first motion appears. 

In the Geometry tab:

●     Select a check representation in the dialog box then the desired check element in the 3D 
view.

●     Click OK to define the motion.
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 3. Select the Go icon  again to define the second motion.

In the Geometry tab:

●     Successively select the two check representations in the dialog box then the desired check 
elements in the 3D view.

●     Set the first and second check modes to To.

●     Set a offset on the first check element to 2mm.

●     Click OK to define the motion.



4. Select the Go icon  again to define the next motion.

In the Geometry tab:

●     Select a check representation in the dialog box then the desired check element in the 3D 
view.

●     Set the check mode to Past.

●     Set a offset on the check element to 5mm.

●     Click OK to define the motion.



5.
Select the Go InDirv icon . 

In the Geometry tab:

●     Select the drive direction in the dialog box then the desired linear element in the 3D view.

●     Select a check representation in the dialog box then the desired check element in the 3D 
view.

●     Set the check mode to To.

●     Click OK to define the motion.

6.
Select the Follow icon . The check curve of the previous motion is used as drive curve. This 
drive element is highlighted in the 3D view.

In the Geometry tab:

●     Select a check representation in the dialog box then the desired check element in the 3D 
view.

●     Set the check mode to To.

●     Click OK to define the motion.



7.
Select the PP word icon , then specify a PP word in the dialog box that appears (DELAY/5, for 
example).

8.
Select the Go Delta icon . 

In the Geometry tab:

●     Set the check mode to Line and distance.

●     Select the line representation in the dialog box then the desired linear element in the 3D 
view.

●     Enter a distance.

●     Click OK to define the motion.



Other optional parameters can be set in the Strategy tab page for each of the motions.  



A tool is proposed by default when you want to create a machining operation. If the proposed 

tool is not suitable, just select the Tool tab page  to specify the tool you want to 

use. Please refer to Edit the Tool of a Lathe Operation.

9. Select the Feeds and Speeds tab page  to specify the feedrates and spindle speed for the 

operation. See Feeds and Speeds for Sequential Turning for more information.

10. Select the Macros tab page  to specify the operation's transition paths (approach and 

retract motion, for example). See Define Macros on a Lathe Operation for an example. 
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Before accepting the operation, you should check its validity by replaying the tool path. 

11. Click OK to create the operation.
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 Turning on a Milling Center with Facing Head

This task illustrates how to create turning operations to machine large diameter holes on a milling center machine equipped 
with a facing head and rotary table. 

The facing head is a mechanism mounted on the head of the milling center to support lathe tools. This configuration can be 
used to machine large diameter holes with better quality than milling. 

In this scenario, the 3 large holes to be machined are located in different turning planes around the table rotary axis (C). 

Each turning plane is defined by two axes (ZX) of a local machining axis system, so that each hole can be reached by 
rotating the table.

The tool mounted on the facing head is piloted along the U-axis to machine along the profile of the hole. 



Open the TurningOperationOnMillMachine.CATProcess document, then select Machining > Lathe Machining from the Start 
menu.

1. Double click the Part Operation and access the Machine editor. A 3-axis rotary table machine is already selected. Make the 
following settings in the Rotary Table tab.
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2. Select the Machining Axis Change icon  to create a local machining axis for the first hole.

Position the origin of the axis by selecting the outer circle of the hole. The axis origin will be positioned at the hole center.

Set the orientation of the X-axis (radial) and Z-axis (axial) by using one of the proposed methods (Selection or Manual 
Components, for example). 
See Insert Machining Axis Change for more information about these methods.

3. Select the Profile Finish Turning icon .

Use the Geometry tab to:
●     select the profile to machine making use of the sensitive Part Element symbol.

●     specify the local plane making use of the sensitive axis system symbol.
Select the local machining axis you created previously. The axial and radial axes (ZX) define the turning plane.

Use the Macro tab to define an approach macro by selecting a start point and a retract macro by selecting an end point.

 

 Use the Macro tab to define an approach macro by selecting a start point and a retract macro by selecting an end point. 
Check the tool path by means of a replay.
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 4. Repeat the steps above to create a local machining axis and a Profile Finish Turning operation for the other two holes.

  

 5. When the 3 turning operations are computed your program should look something like this:

   



 Please note the following points. They are dealt with in more detail in the Methodology section.

●     At each change of turning plane, you must define:
❍     Machining Axis System Change: this is needed for NC data generation

❍     Local Machining Axis on turning operation: this is needed for processing geometry and visualizing the tool 
assembly.

●     NC data output can be generated in XYZ or XYZIJK format. 
For XYZ data, you must generate table rotations in your program.
For XYZIJK data, the value that is output for IJK is taken on the Z axis (spindle) of the local machining axis system.

●     The following NC data statements will be generated at the start of each Turning operation:
❍     The coordinates of the origin of the Local Machining Axis

❍     An order to switch from the X-axis to the U-axis.
This is done through parameterized syntaxes in the PP table (NC_SPINDLE_LATHE or 
NC_LATHE_MO_START_COMMENT).



Manage Local Information on Finishing Operations

This task illustrates how to manage Local Information (local feedrates and offsets) on a Profile Finishing or Groove Finishing 

operation. To create Local Information, you must define the geometry to be machined .

Create a Profile Finishing operation in the program. In the Profile Finishing dialog box that appears, select the Geometry tab 

page .  

 

Local Information can be added on lines, arcs and curves if they are part of a finished profile.

Click the red part in the icon then select the desired finish profile in the 3D window.

 



To create or edit local information
To add local information on an element, right click on it and select the Add Local Information contextual command. 

To edit Local Information from an element, right click on it and select the Edit Local Information contextual command.

In both cases, set the information you want then click OK.

To copy the local information of an element and paste it on another element of the finish profile, right click on it and select the 
Copy Local Information contextual command, then right click on the target element and select the Paste Local Information 
contextual command. 

In the Local Information Browser, you can edit local information by double clicking on the row of the list you are interested in. 

To copy local information from an element and paste it on another element of the finished profile, select an element in the list of 
the Local Information Browser and select the information you want to copy in the right-frame. Then click Paste on and select 
the target element.

Local information is associated to the selected profile and is supported by that profile. If you delete the profile, the associated 
information is also deleted.

To view local information
To browse local information on a finished body, right click on an element of the finished body or on the representation of the Part 
Body in the Geometry tab, then select the Browse Local Information contextual command.

In the Local Information Browser, you can see on the 3D view of the finished body defined local information by clicking on the 
column header.

To remove local information
To remove Local Information from an element, right click on it and select the Remove Local Information contextual command. 

In the Local Information Browser, click on the local information you want to delete and click Remove. 

Options for Inverted Element (for Profile Finishing only)
The inversion of elements is possible for Profile Finishing operations. This is illustrated in the figure below: 

 

In the Strategy tab page, click on the Local Invert tab.

To machine part with inverted elements, several strategies are available:

●     None: the profile is machined with inverted ways of machining.

●     Thickness: a given thickness is let on inverted element and the remaining material is removed when the inverted element is 



machined again.

●     Overlap: a given length of an element is machined twice when the profile is machined and then when inverted elements are 
machined. In this case, you can choose to machine inverted elements first or later.

The lift-off can be linear or circular as specified in the Machining tab.



Update Input Stock - Manual Mode

This task shows you how to update the input stock manually for the machining operations in a lathe 
manufacturing program. These machining operations can be lathe operations, and axial operations 
along the spindle axis.

In Manual mode, the input stock takes into account all the previous operations. The lathe and axial 
operations must be completed.

Please refer to How to Update Input Stock for more information about this capability.

1. Select File > Open then select the StartStockUpdateManualMode.CATProcess document

 2. Select Machining > Lathe Machining from the Start menu.

The Lathe Machining workbench appears. The part is displayed in the Setup Editor window 
along with the manufacturing specification tree. 
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 3. Double click Part Operation.1 in the tree to display the Part Operation dialog box.

Right-click the Stock field to make sure that Automatic Stock Selection for Turning 
Operations is not activated in the contextual menu.

 4. Double click the second lathe operation in the program: External lathe recessing.



 5. In the Geometry page, the status is red because there is no input stock defined for the 
operation.

 6. Select the Update Input Stock command by either clicking the icon  or right-clicking the 

Input stock status field in the sensitive icon. The stock is computed and the corresponding 
sketch profile is displayed in the viewer.



7. Select this profile as the input stock for the operation.

The Geometry page is updated with this stock



You can use the Analyze contextual command (right-click the stock area in the sensitive icon) 
to check that an input stock has been selected.

   

8. Click the Replay icon  to verify the operation.

Click OK to accept the operation.

9. The status of the operation is as follows:

10. The input stock of the other Lathe operations in the program can be updated in the same way.



 Updating Computed Stock Status

For modifications to the Part Operation, a previous operation in the program (edit), or a 
previous sequence of the program (delete or copy/paste), the stock status becomes Stock to 
update.

After modifications, there is no automatic refresh of the stock status of the operations. You can 
right click the Program in the tree and select the Update Computed Stock Status contextual 
command. This will refresh the stock status of all the operations.

Please note that when you copy/paste an operation, the input stock is not copied. 

Removing Input Stock

If you right-click the Input stock status field in the Geometry tab page, you can use the 
Remove Input Stock contextual command  to remove the operation's input stock. The 
corresponding sketch profile will be deleted. The status of the previously selected geometry 
from the deleted sketch will be Not found, so new geometry must be selected in this case.
You cannot use the operation's Cancel button to recover the deleted sketch.



Update Input Stock - Automatic Mode

This task shows you how to update the input stock automatically for the machining operations in a 
lathe manufacturing program. These machining operations can be lathe operations, and axial 
operations along the spindle axis.

In Automatic mode, the input stock takes into account all the previous operations. The axial 
operations must be completed and the lathe operations that use a stock must have either a 
manually selected stock or a saved input stock.

Please refer to How to Update Input Stock for more information about this capability.

1. Select File > Open then select the StartStockUpdateAutoMode.CATProcess document

 2. Select Machining > Lathe Machining from the Start menu.

The Lathe Machining workbench appears. The part is displayed in the Setup Editor window 
along with the manufacturing specification tree. 

 3. Double click Part Operation.1 in the tree to display the Part Operation dialog box.
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Right-click the Stock field to make sure that Automatic Stock Selection for Turning 
Operations is activated in the contextual menu.



 4. Right click the drilling operation in the tree and select the Replay Tool Path icon  to replay 

the operation 

Click OK in the Replay dialog box. The operation status in the tree is now Computed.

 5. Double click the lathe recessing operation in the tree. Select the Strategy tab  in the 

machining operation editor.



Note that:

●     the color of the stock area indicates that stock selection is optional 

●     the Input stock status is Not computed and that the automatic Stock selection is 
activated (Auto. selection).

 6. Click the Tool Path Replay icon  to replay the operation.



Click OK in the Replay dialog box. 

7. In the Strategy tab  the Input stock status is now Up to date.



Click OK in the machining operation editor.

 In the manufacturing specification tree, the operation status is Computed and Stock up to 
date. 



  Computing Stock and Tool Path

For modifications to the Part Operation, previous operation in the program (edit) or previous 
sequence of the program (delete or copy/paste), the stock status becomes Stock to update.

In this case you can right click the Manufacturing Program in the tree and select the Compute 
Stock and Tool Path contextual command. All input stocks and tool paths of the operations 
in the program are recomputed.

Please note that when you copy/paste an operation, the input stock is not copied. 

Removing Input Stock

If you right-click the Input stock status field in the Geometry tab page, you can use the 
Remove Input Stock contextual command  to remove the operation's input stock. The 
corresponding sketch profile will be deleted. The status of the previously selected geometry 
from the deleted sketch will be Not found, so new geometry must be selected in this case.
You cannot use the operation's Cancel button to recover the deleted sketch.



Axial Machining Operations
The tasks for creating axial machining operations are documented in the Prismatic Machining User's Guide.

Spot Drilling Operation

 
Create a Spot Drilling Operation: Select the Spot Drilling icon then select the hole or hole 
pattern to be machined and specify the tool to be used. Specify machining strategy parameters, 
macros and feeds and speeds as needed.

Drilling Operations

 
Create a Drilling Operation: Select the Drilling icon then select the hole or hole pattern to be 
machined and specify the tool to be used. Specify machining strategy parameters, macros and 
feeds and speeds as needed.

 
Create a Drilling Dwell Delay Operation: Select the Drilling Dwell Delay icon then select the hole 
or hole pattern to be machined and specify the tool to be used. Specify machining strategy 
parameters, macros and feeds and speeds as needed.

 
Create a Drilling Deep Hole Operation: Select the Drilling Deep Hole icon then select the hole or 
hole pattern to be machined and specify the tool to be used. Specify machining strategy 
parameters, macros and feeds and speeds as needed.

 
Create a Drilling Break Chips Operation: Select the Drilling Break Chips icon then select the hole 
or hole pattern to be machined and specify the tool to be used. Specify machining strategy 
parameters, macros and feeds and speeds as needed.

Hole Finishing Operations

 
Create a Reaming Operation: Select the Reaming icon then select the hole or hole pattern to be 
machined and specify the tool to be used. Specify machining strategy parameters, macros and 
feeds and speeds as needed.

 
Create a Counterboring Operation: Select the Counterboring icon then select the hole or hole 
pattern to be machined and specify the tool to be used. Specify machining strategy parameters, 
macros and feeds and speeds as needed.

Boring Operations

 
Create a Boring Operation: Select the Boring icon then select the hole or hole pattern to be 
machined and specify the tool to be used. Specify machining strategy parameters, macros and 
feeds and speeds as needed.

 
Create a Boring Spindle Stop Operation: Select the Boring Spindle Stop icon then select the 
hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy 
parameters, macros and feeds and speeds as needed.

 
Create a Boring and Chamfering Operation: Select the Boring and Chamfering icon then select 
the hole or hole pattern to be machined and specify the tool to be used. Specify machining 
strategy parameters, macros and feeds and speeds as needed.
Create a Back Boring Operation: Select the Back Boring icon then select the hole or hole 
pattern to be machined and specify the tool to be used. Specify machining strategy parameters, 
macros and feeds and speeds as needed.

Threading Operations

 
Create a Tapping Operation: Select the Tapping icon then select the hole or hole pattern to be 
machined and specify the tool to be used. Specify machining strategy parameters, macros and 
feeds and speeds as needed.
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Create a Reverse Threading Operation: Select the Reverse Threading icon then select the hole 
or hole pattern to be machined and specify the tool to be used. Specify machining strategy 
parameters, macros and feeds and speeds as needed.

 
Create a Thread without Tap Head Operation: Select the Thread without Tap Head icon then 
select the hole or hole pattern to be machined and specify the tool to be used. Specify 
machining strategy parameters, macros and feeds and speeds as needed.
Create a Thread Milling Operation: Select the Thread Milling icon then select the hole or hole 
pattern to be machined and specify the tool to be used. Specify machining strategy parameters, 
macros and feeds and speeds as needed.

Countersinking and Chamfering Operations

 
Create a Countersinking Operation: Select the Countersinking icon then select the hole or hole 
pattern to be machined and specify the tool to be used. Specify machining strategy parameters, 
macros and feeds and speeds as needed.
Create a Chamfering Two Sides Operation: Select the Chamfering Two Sides icon then select 
the hole or hole pattern to be machined and specify the tool to be used. Specify machining 
strategy parameters, macros and feeds and speeds as needed.

T-Slotting and Circular Milling
Create a T-Slotting Operation: Select the T-Slotting icon then select the hole or hole pattern to 
be machined and specify the tool to be used. Specify machining strategy parameters, macros 
and feeds and speeds as needed.
Create a Circular Milling Operation: Select the Circular Milling icon then select the hole or hole 
pattern to be machined and specify the tool to be used. Specify machining strategy parameters, 
macros, and feeds and speeds as needed.
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Auxiliary Operations
The tasks for inserting auxiliary operations in the manufacturing program are documented in the NC 
Manufacturing Infrastructure User's Guide.

Insert Tool Change: Select the Tool Change icon then select the tool type to be referenced in the 
tool change.
Insert Machine Rotation: Select the Machine Rotation icon then specify the tool rotation 
characteristics.
Insert Machining Axis Change: Select the Machining Axis Change icon then specify the 
characteristics of the new machining axis system.

Insert PP Instruction: Select the PP Instruction icon then enter the syntax of the PP instruction.

Insert COPY Operator (P2 functionality): Select the COPY Operator icon then select the 
reference operation. You can then specify the number of copies and the characteristics of the 
transformation.
Insert TRACUT Operator (P2 functionality): Select the TRACUT Operator icon then select the 
reference operation. You can then specify the characteristics of the transformation.
Insert Copy Transformation Instruction (P2 functionality): Select the Copy Transformation icon 
then select the reference operation. You can then specify the number of copies and the 
characteristics of the transformation.

Opposite Hand Machining: for machining symmetrical parts.
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Part Operations, Manufacturing Programs and 
Machining Processes

The tasks for creating and managing Part Operations, Manufacturing Programs and Machining Processes are 
documented in the NC Manufacturing Infrastructure User's Guide.

Create and Edit a Part Operation: Select the Part Operation icon then specify the entities to be 
referenced by the part operation: machine tool, machining axis system, tool change point, part 
set up, and so on.

Create and Edit a Manufacturing Program: Select the Manufacturing Program icon to add a 
program to the current part operation then insert all necessary program entities: machining 
operations, tool changes, PP instructions, and so on. 

Create a Machining Process (P2 Functionality): Select the Machining Process icon to create a 
machining process, which can then be stored in a catalog.

Apply a Machining Process (P2 Functionality): Select the Open Catalog icon to access the 
machining process to be applied to selected geometry.
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Create a Machining Process for Lathe 
Machining

 
This task shows how to create a machining process for a lathe Threading operation. In this scenario 
you will specify a  tooling query to find an appropriate tool and insert for the operation.

Select an Machining workbench from the Start menu. 
No CATPart or CATProcess is needed at this stage.
If the Machining Process toolbar is not already displayed, select it using View > Toolbars.
Make sure that Start Edit mode is selected in the Operations tab page of Tools > Options > 
Machining.

Initialize the Machining Process

1. Select the Machining Process View icon . The Machining Process View dialog box appears.

2. Select the Machining Process icon . The dialog box is updated with a new machining process 

as shown. 

3.  Select the Lathe Threading icon.
The Lathe Threading dialog box appears.

At this stage you can set certain parameters such as feeds and speeds and machining strategy. 
However, there is only limited access to geometry parameters and it is not possible to specify a 
tool.

4. Just click OK to add a reference Lathe Threading operation to the machining process. 

The reference operation has an associated Tooling Query.

Define the Tooling Query
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5. Double click the Tooling Query associated to the Lathe Threading operation. The Query Definition 
dialog box appears.

Define a simple tooling query as shown below. It corresponds to the criteria:
find a spot drill in the ToolsSampleMP tool repository whose name is Spot Drill D10. 

6. Click OK to assign the tooling query to the Lathe Threading operation.

7. Select File > Save As to save the machining process in a CATProcess document (called
LatheThreadingProcess1.CATProcess, for example).



 

8. Right click the Machining Process in the Machining Process View and select the Save in Catalog 
contextual command.

The Save in Catalog dialog box appears. Click the [...] button and specify a new catalog name 
(catalogAxialMP1.catalog, for example).

Click OK to save the machining process as a component in the specified catalog.

The following are initialized automatically:

●     family name: Machining Process 

●     component name: name given to the machining process using File > Save As.

However, you can change family or component in the Catalog Editor workbench. Click here to 
see how you can organize machining processes in a catalog using the Catalog Editor workbench.

 
 Then you can Apply the Machining Process to the geometry to be machined. The tooling query 

will be resolved at this stage.

Click here to see how you can make use of Knowledgeware functionalities in Machining Processes.
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Machining Resources and Other Entities
Tasks involving machining entities that are specific to the Lathe Machining product can be found in this 
section.

Edit the Insert Holder of a Turning Operation
Edit the Tool Assembly of a Turning Operation

Edit the Insert of a Turning Operation
Edit an Insert Holder in the Resource List
Edit a Tool Assembly in the Resource List

Edit an Insert in the Resource List

The tasks for creating and managing specific entities of the Machining environment are documented in the 
NC Manufacturing Infrastructure User's Guide. 

●      Edit the Tool of a Milling or Drilling Operation: Double click the machining operation in the program 
and select the Tool tab page to edit the characteristics or search for a new tool.

●      Edit a Mill or Drill Tool in the Resource List: Double click a tool referenced in the resource list and 
edit the characteristics in the Tool Definition dialog box.

●      Edit a Mill or Drill Tool Assembly in the Resource List: Double click a tool assembly referenced in the 
resource list and edit the characteristics in the Tool Assembly Definition dialog box.

●      Specify Tool Compensation Information: Double click a tool referenced in the program or resource 
list and specify the tool compensation information in the Compensation tab page of the Tool 
Definition dialog box.

●      Create and Use Machining Patterns: Select Insert > Machining Feature > Machining Pattern then 
select a pattern of holes to be machined.

●      Feature Based Programming: Select a feature using the Manufacturing view and create operations 
based on this feature.

●      Define Macros on a Turning Operation: Select the Macros tab page when creating or editing a 
turning operation, then specify the transition paths of the macros to be used in the operation.

●      Define Macros on an Axial Machining Operation: Select the Macros tab page when creating or editing 
an axial machining operation, then specify the transition paths of the macros to be used in the 
operation.

●      Manage the Status of Manufacturing Entities: Use the status lights to know whether or not your 
operation is correctly defined.
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Edit the Insert Holder of a Turning Operation

This task shows you how to edit the insert holder of a turning operation.

You can do this in several ways:

●     edit its characteristics, thereby creating a new insert holder 

●     replace it by selecting another insert holder that is already used in the document

●     replace it by selecting another insert holder by means of a query.

1. Double click the operation in the program, then select the Insert Holder tab  in the Tooling page .

2. To create a new insert holder:

If you want to change insert holder type, select the icon corresponding to the desired type:

 

 | | | | | | |  

 | | | | | | |  

 | | | | | | -->  Internal Thread Insert Holder

 | | | | | -->  External Thread Insert Holder

 | | | | -->  Frontal Groove Insert Holder

 | | | -->  Internal Groove Insert Holder

 | | -->  External Groove Insert Holder

 | -->  Internal Insert Holder

 -->  External Insert Holder

In this case the corresponding insert holder representation appears in the 2D viewer.



●     Double click the geometric parameter that you want to modify in the 2D viewer, then enter the desired value in the Edit Parameters 
dialog box that appears.

Modify other parameters in the same way. 
The insert holder representation is updated to take the new values into account.

●     Click More to expand the dialog box to access all the insert holder's parameters. 
Modify the values as desired.

●     Enter a name for the new insert holder.

 If the same tooling is used on more than one operation, the parameters of the resource are not accessible for modification (they are 
greyed out).

In this case, you can create a new resource by entering a new identifier in the Name field. You can then specify the parameters of the 
new resource.

3. To select an insert holder that is already used in the document: 
●     Select the [...] button opposite Name. Then select the desired insert holder from the list of insert holders already present in your 

document.

●     In the Name field, enter the name of an insert holder already present in your document.

The insert holder representation is displayed in the 2D viewer. It can be edited as described above. 

4. To select another insert holder by means of a query: 
●     Click the Select an insert holder with query icon opposite Name.

The Search Tool dialog box appears.

●     Use the Look in combo to specify where you want to search for the insert holder:  
❍     in the current document

❍     in a tool catalog

❍     in an external tool database such as the TDM (Tool Data Management) or CATIA Version 4 Manufacturing database.

●     If you want to change insert holder type, select the icon corresponding to the desired insert holder.

●     You can do a quick search in the Simple tab page by entering a character string in the Name field. The insert holders meeting the 
simple search criteria are listed.

●     Select the desired insert holder from the list and click OK.  
The insert holder representation is displayed in the 2D viewer. It can be edited as described above. 
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●     You can search an insert holder using finer constraints by selecting the Advanced tab page. The example below shows the result of a 

search for a right hand insert holder with shank width of 15mm or more in the catalog ToolsSampleLathe.

5. Click OK to confirm using this new insert holder in the operation.

Note that compatibility is checked between the insert and the insert holder.

If there is incompatibily, this is indicated by an exclamation mark symbol on the icon.

In the example below, the selected diamond insert  is compatible with the selected Internal insert holder .

However, it cannot be used on a groove internal insert holder  or a groove external insert holder . 



If, for example, you select a groove internal insert holder, the diamond insert will no longer be referenced by the tool assembly (the status 

light on the Insert tab turns red). Then you will have to select a compatible insert type (such as groove insert ).



Edit the Tool Assembly of a Turning Operation

This task shows you how to edit the tool assembly of a turning operation.

You can do this in several ways:

●     edit its characteristics, thereby creating a new tool assembly 

●     replace it by selecting another tool assembly that is already used in the document

●     replace it by selecting another tool assembly by means of a query.

1. Double click the operation in the program, then select the Tool Assembly tab  in the Tooling page .

2. To create a new tool assembly: 

The parameters of the current tool assembly are shown but are not accessible (greyed out).

Enter a name for the new tool assembly. The parameter fields on the page become accessible.

 If the same tooling is used on more than one operation, the parameters of the resource are not accessible for modification (they are 
greyed out).

In this case, you can create a new resource by entering a new identifier in the Name field. You can then specify the parameters of 
the new resource.

3. To select a tool assembly that is already used in the document: 
●     Select the [...] button opposite Name. Then select the desired tool assembly from the list of tool assemblies already present in 

your document.

●     In the Name field, enter the name of a tool assembly already present in your document.

4. To select another tool assembly by means of a query: 
●     Click the Select a tool assembly with query  icon opposite Name.

The Search Tool Assembly dialog box appears.



●     Use the Look in combo to specify where you want to search for the tool assembly:  
❍     in the current document

❍     in a tool catalog

❍     in an external tool database such as the TDM (Tool Data Management) database. 

●     You can do a quick search in the Simple tab page by entering a character string in the Name field. The tool assemblies meeting 
the simple search criteria are listed.

●     Select the desired tool assembly from the list and click OK.

 
●     You can search a tool assembly using finer constraints by selecting the Advanced tab page. 

5. Click OK to confirm using this new tool assembly in the operation.
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Edit the Insert of a Turning Operation

This task shows you how to edit the insert of a turning operation.

You can do this in several ways:

●     edit its characteristics, thereby creating a new insert 

●     replace it by selecting another insert that is already used in the document

●     replace it by selecting another insert by means of a query.

1. Double click the operation in the program, then select the Insert tab  in the Tooling page .

2. To create a new insert: 

If you want to change insert type, select the icon corresponding to the desired type:

 | | | | | | |  

 | | | | | | |  

 | | | | | | -->  Thread Insert

 | | | | | -->  Groove Insert

 | | | | -->  Trigon Insert

 | | | -->  Triangular Insert

 | | -->  Square Insert

 | -->  Diamond Insert

 -->  Round Insert



In this case the corresponding insert representation appears in the 2D viewer.

●     Double click the geometric parameter that you want to modify in the 2D viewer, then enter the desired value in 
the Edit Parameters dialog box that appears.

Modify other parameters in the same way. 
The insert representation is updated to take the new values into account.

●     Click More to expand the dialog box to access all the insert's parameters. 
Modify the values as desired.

●     Enter a name for the new insert.

 If the same tooling is used on more than one operation, the parameters of the resource are not accessible for 
modification (they are greyed out).

In this case, you can create a new resource by entering a new identifier in the Name field. You can then specify the 
parameters of the new resource.

3. To select an insert that is already used in the document: 
●     Select the button opposite Name. Then select the desired insert from the list of inserts already present in your 

document.

●     In the Name field, enter the name of an insert already present in your document.

The insert representation is displayed in the 2D viewer. It can be edited as described above. 



4. To select another insert by means of a query: 
●     Click the Select an insert with query  icon opposite Name.

The Search Tool dialog box appears.

●     Use the Look in combo to specify where you want to search for the insert:  
❍     in the current document

❍     in a tool catalog

❍     in an external tool database such as the TDM (Tool Data Management) or CATIA Version 4 Manufacturing 
database.

Note that Cutting conditions (feeds and speeds) can be included in a tool catalog and in the TDM. Please refer 
Feeds and Speeds for more information.

●     If you want to change insert type, select the icon corresponding to the desired insert.

●     You can do a quick search in the Simple tab page by entering a character string in the Name field. The inserts 
meeting the simple search criteria are listed.

●     Select the desired insert from the list and click OK.  
The insert representation is displayed in the 2D viewer. It can be edited as described above. 

 
●     You can search an insert using finer constraints by selecting the Advanced tab page.

5. Click OK to confirm using this new insert in the operation.

Note that compatibility is checked between the insert and the insert holder.

If there is incompatibily, this is indicated by an exclamation mark symbol on the icon.

In the example below, the selected diamond insert  is compatible with the selected Internal insert holder .

However, it cannot be used on a groove internal insert holder  or a groove external insert holder . 
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If you select a groove insert , the internal insert holder will no longer be referenced by the tool assembly (the 

status light on the Insert Holder tab turns red). Then you will have to select a compatible insert holder type (such as 
groove internal insert holder).



Edit an Insert Holder in the Resource List

This task shows you how to edit an insert holder that is already used in your document.

Note that if you edit a resource that is used by one or more machining operations, then these 
operations will be impacted by the modification.

1. Double click the desired insert holder in the Resource List.

You can also right-click it and select the Edit NC Resource contextual command.

The Tool Definition dialog box is displayed allowing you to edit the insert holder's geometric, 
technological, and compensation parameters.

 Please refer to Tools/Insert Holders for Turning Operations for a description of the available 
parameters for this resource.

2. If needed, enter a new name and comment for the insert holder. 

3. Click More to expand the dialog box to access the Geometry, Technology, and Compensation 
tabs.
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4. You can specify the insert holder geometry in two ways: 
●     double click a parameter in the large insert holder icon and enter the desired value in the 

Edit Parameter dialog box that appears

●     or enter the desired values in the Geometry tab page.

The icon representation of the insert holder is updated with these values.

5. Click the Technology tab and enter the desired values for the insert holder's technological 
parameters. 



6. If cutter compensation is required, click the Compensation tab. 

You can either edit an existing compensation site or add another site, if other sites are proposed. 

7. Right click the desired line to either edit or add cutter compensation data.

The Compensation Definition dialog box appears.

8. Enter the desired values for the cutter compensation sites.  

See Specify Tool Compensation for more information.

9. Click OK to accept the modifications made to the insert holder.

A CATPart or CATProduct representation can be assigned to the insert holder by means of the 
Add User Representation contextual command in the Resource List.

A mask symbol on the bottom right of the Insert Holder icon in the PPR tree indicates that a user 
representation has been added to the resource. For example:

For more information about user representations, please refer to User Representation of Lathe 
Tools.
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Edit a Tool Assembly in the Resource List

This task shows you how to edit a tool assembly that is already used in your document.

Note that if you edit a resource that is used by one or more machining operations, then these 
operations will be impacted by the modification.

1. Double click the desired tool assembly in the Resource List.

You can also right-click it and select the Edit NC Resource contextual command.

The Tool Assembly Definition dialog box is displayed allowing you to edit the tool assembly's 
geometric and technological parameters.

 Please refer to Lathe Assembly Resources for a description of the available parameters.

2. If needed, enter a new name and comment for the tool assembly. 

3. If needed, use the spinner to change the Tool number. This parameter identifies tool in the tool 
storage magazine.

4. Click More to expand the dialog box to access the Geometry and Technology tabs.

5. You can specify the tool assembly geometry in two ways: 
●     double click a parameter in the large tool assembly icon and enter the desired  value in the 

Edit Parameter dialog box that appears

●     or enter the desired values in the Geometry tab page.
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6. Click the Technology tab and enter the desired values for the tool assembly's technological 
parameters. 

7. Click OK to accept the modifications made to the tool assembly.

A CATPart or CATProduct representation can be assigned to the tool assembly by means of the 
Add User Representation contextual command in the Resource List. 

If a component (insert holder or insert) of the assembly has a user representation, then that 
representation will not be taken into account. The assembly representation has priority.

A mask symbol on the bottom right of the Tool Assembly icon in the PPR tree indicates that a 
user representation has been added to the resource. For example:

For more information about user representations, please refer to User Representation of Lathe 
Tools.
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Edit an Insert in the Resource List

This task shows you how to edit a lathe insert that is already used in your document.

1. Right-click the desired insert in the resource list, and select the Edit NC Resources contextual 
command.

Note that if you edit a resource that is used by one or more machining operations, then these 
operations will be impacted by the modification.

The Insert Definition dialog box is displayed allowing you to edit the insert's characteristics.

2.  If needed, enter a new name for the insert. 

You can also assign a comment.

3.  If needed, use the spinner to change the Tool number.

4. Click More to expand the dialog box to access the Geometry, Technology, and Feeds & Speeds 
tabs.



 Please refer to Insert Resources for a description of the available parameters.

5. You can specify the insert geometry in two ways: 
●     double click a parameter in the large icon representing the insert and enter the desired value 

in the Edit Parameter dialog box that appears

●     or enter the desired values in the Geometry tab page.

6. Click the Technology tab and enter the desired values for the insert's technological 
parameters. 
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7. Click the Feeds and Speeds tab and enter the desired values for the insert's feed and speed 
parameters. 

8. Click OK to accept the modifications made to the insert.

A CATPart or CATProduct representation can be assigned to the insert by the Add User 
Representation contextual command in the Resource List.

A mask symbol on the bottom right of the Insert Holder icon in the PPR tree indicates that a user 
representation has been added to the resource. For example:

For more information about user representations, please refer to User Representation of Lathe 
Tools.
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Verification, Simulation and Program Output
The tasks for using capabilities such as tool path verification, material removal simulation, and production 
of NC output data are documented in the NC Manufacturing Infrastructure User's Guide.

Replay Tool Path: Select the Tool Path Replay icon then specify the display options for an 
animated tool path display of the manufacturing program of machining operation.
Simulate Material Removal (P2 functionality): Select the Video icon in the Tool Path Replay 
dialog box to run a material removal simulation in Video mode.

●     Generate APT Source Code in Batch Mode: Select the Generate NC Code in Batch Mode icon 
then select the manufacturing program to be processed and define the APT source 
processing options.

●     Generate NC Code in Batch Mode: Select the Generate NC Code in Batch Mode icon then 
select the manufacturing program to be processed and define the NC code processing 
options.

●     Generate Clfile Code in Batch Mode: Select the Generate NC Code in Batch Mode icon then 
select the manufacturing program to be processed and define the Clfile processing options.

●     Generate a CATProduct In-Process Model in Batch Mode (P2 functionality): Select the 
Generate NC Code in Batch Mode icon then select the manufacturing program to be 
processed and specify the processing options for generating a CATProduct in-process model.

●     MfgBatch Utility that allows you to generate NC data files from a manufacturing program by 
means of an executable program under Windows or a shell under UNIX.

Generate NC Code in Interactive Mode: Select the Generate NC Code Interactively then select 
the manufacturing program to be processed and define processing options.
Batch Queue Management: Manage tool path computation outside the interactive CATIA 
session, with the possibility of scheduling the execution of several batch jobs.
Generate Documentation: Select the Generate Documentation icon to produce shop floor 
documentation in HTML format. 
 Import an APT Source into the Program: Select the APT Import contextual command to insert 
an existing APT source into the current manufacturing program. 
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Workbench Description
This section contains the description of the menu commands and icon toolbars that are specific to the Lathe Machining workbench.

Menu Bar
Toolbars

Specification Tree

 

 



Lathe Machining Menu Bar 
The menu commands that are specific to Lathe Machining are described below. 

Start File Edit View Insert Tools Windows Help

Tasks corresponding to general menu commands are described in the CATIA Version 5 Infrastructure User's Guide.

Tasks corresponding to menu commands that are common to all Machining products are described in the NC Manufacturing 
Infrastructure User's Guide.

Insert Menu
Machining Operations:

Auxiliary Operations:

Machining Features:

Insert > Machining Operations
 Command... Description...

Rough Turning Create a Longitudinal Rough Turning 
Operation 
Create a Parallel Contour Rough Turning 
Operation
Create a Face Rough Turning Operation

Groove Turning Create a Groove Turning Operation

Recess Turning Create a Recess Turning Operation



Profile Finish Turning Create a Profile Finish Turning Operation

Groove Finish Turning Create a Groove Finish Turning Operation

Thread Turning Create a Thread Turning Operation

Sequential Turning Create a Sequential Turning Operation

Ramp Rough Turning Create a Ramp Rough Turning Operation

Ramp Recess Turning Create Ramp Recess Turning Operation

Axial Machining Operations Create Axial Machining Operations

Insert > Auxiliary Operations > Turning Tool Change

 

Description... 

Allows inserting turning tool changes in the program.



Lathe Machining Toolbars
The Lathe Machining workbench includes a number of icon toolbars, some of which are common to all NC workbenches and 
some of which are specific to Lathe Machining. The common toolbars are described in the Toolbars section of the NC 
Manufacturing Infrastructure User's Guide.

The following toolbar is specific to the Lathe Machining workbench.

It contains commands to create and edit turning operations as follows.

Create a Rough Turning operation. 
Basic tasks illustrate the following roughing modes: 

●     Longitudinal

●     Face

●     Parallel Contours.

Create a Recess Turning operation.

Create a Groove Turning operation.

Create a Profile Finish Turning operation.

Create a Groove Finish Turning operation.

Create a Thread Turning operation.

Create a Sequential Turning operation.

Create a Ramp Rough Turning operation.

Create a Ramp Recess Turning operation.

 
Create Axial Machining Operations.

The following specific toolbar is accessed from the drop-down icon in the Auxiliary Operations toolbar.

It contains icons for creating and editing Turning Tool Change operations as follows.

See External tool for more information about this resource

See Internal tool for more information about this resource

See External Groove tool for more information about this resource

See Frontal Groove tool for more information about this resource
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See Internal Groove tool for more information about this resource

See External Thread tool for more information about this resource

See Internal Thread tool for more information about this resource.

Please note that the icon representing a Tool Change operation in the PPR tree looks like this: .

file:///E|/www/jmndocr15/Doc/online/mfgug_C2/mfgugrf0700.htm#GrooveInternalTool
file:///E|/www/jmndocr15/Doc/online/mfgug_C2/mfgugrf0700.htm#ThreadExternalTool
file:///E|/www/jmndocr15/Doc/online/mfgug_C2/mfgugrf0700.htm#ThreadInternalTool


Specification Tree
Here is an example of a Process Product Resources (PPR) specification tree for Machining products. 

Process List is a plan that gives all the activities and machining operations required to transform a part 
from a rough to a finished state. 

●     Part Operation defines the manufacturing resources and the reference data.

●     Manufacturing Program is the list of all of the operations and tool changes performed. The example 
above shows that: 

❍     Drilling.1 is complete and has not been computed

❍     Drilling.2 is complete but has been computed (by means of a replay)

❍     Drilling.3 does not have all of the necessary data (indicated by the exclamation mark symbol)

❍     Drilling.4 has been deactivated by the user (indicated by the brackets symbol)

❍     Drilling.5 has been modified and needs to be recomputed (indicated by the update symbol).

Product List gives all of the parts to machine as well as CATPart documents containing complementary 
geometry. 
Resources List gives all of the resources such as machine or tools that can be used in the program.



Customizing

This section describes how to customize settings for Machining.

Before you start your first working session, you can customize the settings to suit your working habits. Your 
customized settings are stored in permanent setting files: they will not be lost at the end of your session.

Other tasks for customizing your Machining environment are documented in the NC Manufacturing Infrastructure 
User's Guide:

Build a Tools Catalog
Access External Tools Catalogs
Add User Attributes on Tool Types 
PP Word Syntaxes 
NC Documentation 
Workbenches and Tool Bars

1. Select Tools > Options from the menu bar: the Options dialog box appears. 

2. Select the Machining category in the tree to the left. The options for Machining settings appear, organized in tab 
pages. 

3. Select the tab corresponding to the parameters to be customized.

Parameters in this tab... Allow you to customize...

General general settings for all Machining products

Resources tooling, feeds&speeds and resource files 

Operation machining operations

Output PP files and NC data output

Program manufacturing programs (sequencing, and so on)

Photo/Video material removal simulation 

4. Set these options according to your needs. 

5. Click OK to save the settings and quit the Options dialog box. 
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General

This document explains how to customize general settings for Machining products.

Select the General tab, which is divided up into areas.

Parameters in this area... Allow you to customize...

Performance settings for optimized performance

Tree Display display of the specification tree

Color and Highlight colors of displayed geometry and parameters

Tool Path Replay tool display during tool path replay

Complementary Geometry handling of geometry necessary for manufacturing

Design Changes use of the Smart NC mode and enhanced detection of design 
changes.

Performance

Click the Optimize button in order to automatically set a number of the Machining options for optimized performance. These 
options are listed in the Information dialog box that appears: 



If you click Yes, these options will be set as described in the dialog box. Note that, if needed, you may locally reset any of 
these options.
If you click No, the options will remain with their current settings.

The Information box also lists some recommendations for manually setting other options that have an influence on 
performance. 

Tree Display

●     Select the checkbox if you want the status of activities in the tree to be updated automatically. 

●     If this checkbox is not selected:

❍     you can update activity status manually in your workbench using the Update Status icon  in the Auxiliary 
Commands toolbar. 

❍     the status of the activity after a manual update is masked at the first action on the node (for example, edit, replay, 
collapse/expand of a parent node). To retrieve the status of the activity you must select the Update Status icon 
again. 



If this checkbox is not selected, performance is improved.

 By default, the checkbox is not selected.

Color and Highlight

●     Select the colors to be used for identifying the various manufacturing entities by means of the combos. 
Note that for Geometry that is not found or not up to date, you can select the colors used to display the valuated 
parameters in the corresponding Operation or Feature dialog boxes.

●     For certain entities, you can select the corresponding checkbox to use highlighting. 
Performance is improved when all the Highlight checkboxes are selected.

Tool Path Replay

Display tool near cursor position on tool path

Select this checkbox if you want to display the tool near your cursor position on the trajectory during a tool path replay. You 
can display the tool at a specific point by clicking on the tool path. The tool will then be positioned on the nearest computed 
point on the trajectory. 

Display tool center instead of tool tip

Select this checkbox if you want to display the tool center point instead of the tool tip during a tool path replay.



Display circles

Select this checkbox if you want to display each circular trajectory as a circular arc instead of a set of discretization points. 
The extremities of the circular arc are indicated by means of 'O' symbols.
This allows better control of the Point by Point replay mode, where it is necessary to make several interactions to replay a 
circle (because of its representation by a set of points). With the graphic representation as a circle, only one interaction is 
necessary to perform the replay.

 By default, these checkboxes are not selected.

Color of feedrates

Select the colors to be used for identifying the various feedrate types by means of the combos. The selected colors will be 
displayed in the Different colors replay mode. 

Complementary Geometry

Select the checkbox to create a CATPart dedicated to manufacturing-specific geometry in the Product List of the PPR tree.

 By default, the checkbox is not selected.

Design Changes

Smart NC mode

Select this checkbox to activate the Smart NC mode. In this mode, an image of the geometry selected in machining 
operations is kept to allow analysis of design changes.
Performance is improved when this checkbox is not selected.

Optimized detection of design changes

Select this checkbox to enable a geometrical comparison mode in order to more precisely determine the design change 
status of machining operations.

 By default, these checkboxes are not selected.



Resources

This document explains how to customize resource settings for Machining products.

Select the Resources tab, which is divided up into areas. 

Parameters in this area... Allow you to customize...

Catalogs and Files the path name for resource files

Tool Selection the selection of tools

Automatic Compute from Tool Feeds and 
Speeds

the update of feeds and speeds according to tooling data

Tool Query Mode in Machining Processes 
Instantiation

tool queries in machining processes

Catalogs and Files 

Enter the path of the folder containing tool catalogs, PP tables, macros, and machining processes. You can choose a folder by clicking 
the [...] button.

You can concatenate paths using:

●     a semi colon (;) character for Windows platforms

●     a colon (:) character for UNIX platforms.

For example, if the concatenated folders E:\DownloadOfCXR12rel\intel_a\startup and e:\users\jmn\NC in the figure above contain PP 
tables, then those PP tables will be available for selection in the Part Operation's Machine Editor dialog box.

Please note that:

●     PP tables must be contained in folders named Manufacturing\PPTables

●     tools must be contained in folders named Manufacturing\Tools.

Tool Selection 

Automatic query after modification

Select this checkbox if you want to to activate an automatic query after each modification of a tool parameter. Performance is improved 
when this checkbox is not selected.

Tool preview after selection

Select this checkbox if you want to preview the tool after selection.

 By default, these checkboxes are selected.



Automatic Compute from Tool Feeds and Speeds

Feedrate attributes of the operation

Select this checkbox if you want the Automatic Update of Feedrates option to be set by default in the Feeds and Speeds tab page of 
machining operations.
This option allows feedrates of operations to be automatically updated whenever feedrate information on the tool is modified.

Spindle attributes of the operation

Select this checkbox if you want the Automatic Update of Speeds option to be set by default in the Feeds and Speeds tab page of 
machining operations.
This option allows spindle speeds of operations to be automatically updated whenever speed information on the tool is modified.

 By default, these checkboxes are selected.

Tool Query mode in Machining Processes Instantiation

Select the type of Tool Query to be executed when a Machining Process is instantiated:

●     automatically computed Tool Query

●     interactively defined Tool Selection in case of multiple results

●     interactively defined Tool Selection if no tool is found.

Depending on the selected option, the Advanced tab page of the Search Tool dialog box shows the solved Tool Query for each operation 
in the Machining Process.

 By default, the Automatic Tool Query option is selected.

In the example below, you can choose one of the tools found in the ToolsSampleMP, or use the Look in combo to select a tool from 
the current document or another tool catalog. 





Operation

This document explains how to customize machining operation settings for Machining products.

Select the Operation tab, which is divided up into areas. 

Parameters in this area... Allow you to customize...

Default Values the use of default values

After Creation or Machining Process (MP) 
Instantiation

what happens after creating machining operations or machining 
processes

When Copying the duplication of geometry links

Display tool path displays of operations

User Interface dialog boxes of 3-axis surface machining operations.

Default Values

Select the checkbox if you want operations to be created with the values used in the current program. 
The values and units of attributes at the creation step of an operation are set to the values and units of the last edited and 
validated operation whatever its type (that is, exit the operation definition dialog box using OK).

Otherwise the default settings delivered with the application are used.

 By default, this checkbox is selected.

After Creation or Machining Process (MP) Instantiation

Select the desired checkboxes to specify conditions to be applied when you create machining operations or machining 
processes.

Sequence machining operation

Machining operations are automatically sequenced in the current program after creation. 
Otherwise, sequencing can be managed in the feature view.

Search compatible tool in previous operations

When creating an operation, if a compatible tool exists in a previous operation of the current program, it will be set in the 



new operation. 
Otherwise, the operation will be incomplete.

Use a default tool

When creating an operation, a search is done in the document to find a compatible tool. If no compatible tool exists, a 
default one is created in the document and set in the created operation.
If checkbox is not selected, no tool will be defined on the operation.

Start edit mode (not available for machining processes)

When creating a machining operation, Edit mode is automatically started to allow modifying parameters of the created 
operation.
Otherwise, the operation is added to the program but the machining operation editor is not started.

MP instantiation: keep the absolute position of the tool axis

When a machining process is instantiated, the tool axes of the activites in the MP keep their absolute positions. Otherwise, if 
the checkbox is not selected, these positions are changed in order to keep the relative components of the tool axis.

 By default, these checkboxes are selected.

When Copying

Select the checkbox if you want geometry links to be duplicated in a copied operation.

Otherwise the geometry must be defined for the copied operation. Performance is improved when this checkbox is not 
selected.

 By default, this checkbox is selected.

Display

Select the checkbox if you want to display tool paths of operations in the current Part Operation.

 By default, this checkbox is not selected.

User Interface

Select the checkbox if you want to have the possibility of simplifying the dialog boxes of machining operations (that is, you 
can display the minimum number of parameters necessary for a correct tool path). This setting is available for 3-axis surface 
machining operations only. 

 By default, this checkbox is not selected.



Output

This document explains how to customize data output settings for Machining products.

Select the Output tab, which is divided up into areas. 

Parameters in this area... Allow you to customize...

Post Processor the type of PP files to be used for generating NC code output and 
the path where these files are located

Tool Path Storage the tool path storage capability

Tool Path Edition the tool path edition capability

During Tool Path Computation contact point storage

Tool Output Point type of tool output point

Tool Output Files ... Location default paths for NC output files storage.

Post Processor

Select the desired Processor option:

●     None: no Post Processor is defined. NC code output is not possible in this case

●     Cenit: you can choose from among the Post Processor parameter files proposed by Cenit to generate your NC code

●     IMS: you can choose from among the Post Processor parameter files proposed by Intelligent Manufacturing Software 
(IMS) to generate your NC code

●     ICAM: you can choose from among the Post Processor parameter files proposed by ICAM Technologies Corporation 
(ICAM) to generate your NC code.

Enter the path of the folder containing Post processors. You can choose a folder by clicking the [...] button. File 
concatenation is possible.

 By default, the None option is selected.

Tool Path Storage



Select the desired option to store tool path data either in the current document or in an external file (as a tpl file).

For operations with large tool paths (more than 100 000 points), tool path storage in an external file is recommended. 

 By default, the Store tool path in the current document option is selected.

Tool Path Edition

Select the checkbox if you want to be able to edit tool paths even when the operation is locked. 

This capability is available only for activities with a tool path node in the specification tree.

 By default, this checkbox is selected.

During Tool Path Computation

Select the checkbox if you want to store contact points in the tool path.

Performance is improved when this checkbox is not selected.

 By default, this checkbox is selected.

Tool Output Point

Select the desired option to select one of the following as output point:

●     tool tip

●     tool center point

●     tool center point for ball end tools (that is, any tool with the Ball-end tool attribute selected or an end mill whose nominal 
diameter is equal to twice the corner radius).

Performance is better when the Tool Tip option is selected.

 By default, the Tool Tip option is selected.

Default File Locations



Specify default locations for storing Tool Path files, NC Documentation, and NC Code output. 

You can store tool paths files (tpl files) in the same folder as the CATProcess by selecting the checkbox. This allows you to 
store these files according to your CATProcess context. Otherwise, you can choose another location by clicking the [...] 
button.

For NC Documentation, and NC Code output you can choose a folder easily by clicking the [...] button. 

You can customize the extension to be used for NC Code output (by default, the suffix used is CATNCCode).

Please note that Video results are stored in the NC Code output directory. This is done by using the Associate Video Result 

to Machining Operation icon  in the Tool Path Replay dialog box.

 By default, the Tool path: Store at same location as the CATProcess checkbox is not selected.



Program

This document explains how to customize manufacturing program settings for Machining products.

Select the Program tab to customize program auto-sequencing rules and priorities. These settings are 
mainly intended for the administrator.

Make sure that the document in the sequencing rules path (AllSequencingRules.CATProduct in the example 
below) is accessible in Read/Write.

Auto Sequencing

 

Access to sequencing rules settings

Select the Access to sequencing rules settings checkbox to authorize user access to sequencing rules.

You can then specify the path for the rules base 
You can choose a rules base easily by clicking the [...] button.

 By default, this checkbox is selected.

Display sequencing rules and priorities

Select the Display sequencing rules and priorities checkbox to authorize the display of sequencing rules 
and priorities in the user's view. In this case two more checkboxes can be selected in order to: 

●     allow the user to filter rules 

●     allow the user to modify rule priorities.

 By default, these checkboxes are selected.



Photo/Video

This document explains how to customize material removal simulation settings for Machining products.

Select the Photo/Video tab, which is divided up into areas. 

Parameters in this area... Allow you to customize...

Simulation at material removal simulation at program of Part Operation level

Video Video material removal simulation options

Photo Photo material removal simulation options

Performance settings that influence performance

Color color during material removal simulation

Positioning Move allowed tool axis variation between two operations

Simulation at 

Select the desired option to perform material removal simulation at either Program or Part Operation level. 
Depending on the selected level, simulation begins either from the start of the manufacturing program or from the start of 
the Part Operation. 
Best performance is obtained with Program level.

 By default, the Program level option is selected.

Video 

Stop at tool change

Select the Stop at tool change checkbox if you want the Video simulation to stop each time a tool change is encountered 
in the program.

 By default, this checkbox is not selected.

Collision detection

Select the desired Collisions detection option to: 

●     ignore collisions during the Video simulation



●     stop the Video simulation at the first collision

●     continue the Video simulation even when collisions are detected. In this case, you can consult the list of collisions at any 
time during the simulation.

Best performance is obtained when collisions are ignored.

 By default, the Ignore option is selected.

Touch is collision

Select the Touch is collision checkbox if you want touch (or contact) type of collision to be detected. 

 By default, this checkbox is selected.

Multiple Video result on program

Select the Multiple Video result on program checkbox if you want to store video results on more than one operation in 
the program. 

 By default, this checkbox is not selected. 

Photo

Select the desired Fault box type for examining remaining material or gouges:

●     Transparent: to display a transparent bounding box

●     Wireframe: to display a wireframe bounding box

●     None: if no bounding box is required.

 By default, the Wireframe option is selected.

Select the checkbox to compute all information at the picked point.

 By default, this checkbox is not selected.

Best performance is obtained when Fault box: None is set and the Compute all information at picked point checkbox is 
not selected.

Performance 



Tool and faceting

There are three methods of tool faceting used in Video simulation: Standard, Smaller and Larger. 
The number of facets for a tool representation is determined by the chord deviation that is set for the tool diameter (0.005% 
of the tool diameter). 

●     Smaller: The picture shows a rough approximation of a tool with six facets. Note that the chord deviation is always 
inside the actual circle, and that the points are always on the circle (accurate).  

This is the most accurate method for the Arc through Three Points command.

●     Standard: The picture shows a rough approximation of a tool with six facets. Note that the chord deviation is partly 
inside and partly outside the actual circle, and that the points are not always on the circle.

This is the best method for material removal simulation. 
However, this is not suitable for the Arc through Three Points command.

●     Larger: The picture shows a rough approximation of a tool with six facets. Note that the chord deviation is outside the 
actual circle, and that the points are not on the circle.



This is not suitable for the Arc through Three Points command.
However, it can be useful for gouge detection.

 By default, the Standard option is selected.

Photo resolution

Best performance is obtained when the Photo resolution is set to 0. In this case, a detailed simulation of a portion of the part 
can be obtained using the Closeup command.
Increasing the resolution improves machining accuracy and gives a very detailed simulation. However, this requires 
increased memory and computation time.

 By default, this resolution is set to 0.

Tool axis interpolation angle (5-axis only)

Specify the maximum angle that the tool axis is allowed to vary between two consecutive points. 
Best performance is obtained for an angle of 10 degrees. Decreasing the angle improves the precision of the simulation. 
However, this requires increased memory and computation time.

 By default, this angle is set to 1degree.

Optimized rendering for Video

Set the Optimized rendering for Video checkbox to obtain an optimized rendering that improves Video simulation 
performance.
Otherwise, more realistic colors are obtained with a slightly degraded performance. Milling, drilling, and turning operations 
are supported .

 By default, this checkbox is selected.

Color 



Set the tool (and associated machined area) color to be the same as or different from the last tool, or have different colors 
for all tools. Best performance is obtained with same colored tools.

 By default, the All different option is selected.

Assign colors to the different tools using the associated color combo.

Assign colors to tool holders, parts, and fixtures using the associated color combos.

Positioning Move

Set the Maximum tool axis variation that is to be allowed between the end point of an operation and the start point of 
the next operation. If the tool axis varies by an amount greater than the specified value, then the tool is positioned at the 
start of the following operation.

 By default, this angle is set to 1degree.



Reference Information
Reference information that is specific to the Lathe Machining product can be found in this section. 

Rough Turning Operations
Recess Turning Operations
Groove Turning Operations

Profile Finish Turning Operations
Groove Finish Turning Operations
Ramp Rough Turning Operations
Ramp Recess Turning Operations

Thread Turning Operations
Sequential Turning Operations

Tool Assembly Conventions for Turning

Essential reference information on the following topics is provided in the NC Manufacturing Infrastructure 
User's Guide. 

NC Manufacturing Resources
NC Macros

PP Tables and PP Word Syntaxes
Feeds and Speeds

APT Formats
CLfile Formats 
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Rough Turning Operations
The information in this section will help you create and edit Rough Turning operations in your manufacturing 
program. 

The Rough Turning operation allows you to specify: 

●     Longitudinal, Face and Parallel Contour roughing modes

●     external, internal or frontal machining according to the type of area to machine

●     relimitation of the area to machine

●     various approach and retract path types

●     various lead-in and lift-off options with specific feedrates

●     recess machining

●     various contouring options with specific feedrates.

The following topics are dealt with in the paragraphs below:

●     Tooling

●     Geometry including Part and Stock Offsets

●     Location and Limits

●     Machining Strategy Parameters

●     Feeds and Speeds

●     Tool Compensation

●     Macros.

Tooling for Rough Turning

The following tooling may be used: 

●     External and Internal insert-holders with all insert types except groove and thread.

●     External and Internal Groove insert-holders with groove inserts. 

Note that the following attributes may influence machining (they are located on the Insert-holder's Technology 
tab):

●     Gouging angle

●     Trailing angle

●     Leading angle

●     Max Recessing Depth

●     Max Cutting Depth

●     Max Boring Depth.

These attributes take tooling accessibility into account and may reduce the machined area.
However, you can use the Insert-Holder Constraints option on the operation editor to either ignore or apply 
these tooling attributes. You can replay the operation to verify the influence of these attributes on the generated 



tool path.

Note that the Insert-Holder Constraints setting does not influence the Leading and Trailing Safety Angles 
defined in the operation editor.

Geometry for Rough Turning

Part and Stock profiles are required. They can be specified as follows:

●     select edges either directly or after selecting the By Curve contextual command. In this case the Edge 
Selection toolbar appears to help you specify the guiding contour.

●     select the Sectioning contextual command. Please refer to Sectioning for details of how to use this capability.
Please note that the sectioning selection method is not associative.

The End Limit option allows you to specify a point, line, curve or face to relimit or extrapolate the selected part 
profile. If a face is specified, the end element is the intersection of the face and the working plane. The position of 
the end of machining is defined with respect to this element by one of the following settings: None / In / On / Out.

Relimiting the area to machine by means of limit elements

If you specify a point, it is projected onto the part profile. 
A line through the projected point parallel to the radial axis delimits the area to machine.

If you specify a line, its intersection with the part profile is calculated (if necessary, the line is extrapolated). 
A line through the intersection point parallel to the radial axis delimits the area to machine.

If you specify a curve, its intersection with the part profile is calculated (if necessary, the curve is extrapolated 
using the tangent at the curve extremity). 
A line through the intersection point parallel to the radial axis delimits the area to machine.

Orientation for Rough Turning

The following Orientations are proposed: Internal, External and Frontal (for Face and Parallel Contour Rough 
Turning only).

The selected Orientation defines the type of geometric relimitation to be done between the stock and part 
geometry in order to determine the area to machine. Selected part and stock profiles do not need to be joined (see 
the following figures).

External Rough Turning
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Internal Rough Turning

 

Frontal Rough Turning 

Frontal machining is proposed for face Rough Turning. In that case, the minimum and maximum diameters of the 
area to machine are determined by the stock profile dimensions. 

For example, in the following figure the area to machine is relimited by the spindle axis because the stock profile is 
also relimited by the spindle axis. 



 

Part and Stock Offsets for Rough Turning

●     Stock offset: specifies a virtual displacement of the stock profile.

●     Part offset: specifies a virtual displacement of the part profile.

 

●     Axial part offset: specifies a virtual displacement of the part profile along the spindle axis direction.



 

●     Radial part offset: specifies a virtual displacement of the part profile in the radial axis direction.

 

●     End limit offset: distance with respect to the end element (only if end element is a line or a curve, and when 
In or Out  is set for end element positioning).

Offsets can be positive or negative with any absolute value. The global offset applied to the part profile is the 
resulting value of the normal, axial and radial offsets.

Location and Limits for Rough Turning

The following machining Locations are proposed:

●     Front, the part is machined toward the head stock

●     Back, the part is machined from the head stock.



 

Orientation and Location settings determine the way the program closes the area to machine using radial, axial, 
axial-radial or radial-axial relimitation. 

The following options allow you to restrict the area to machine that is pre-defined by the stock and part. You may 
want to restrict this area due to the physical characteristics of the tool and the type of machining to be done.

Minimum Machining Radius 

 

Maximum Machining Radius (for internal machining) 



 

Note that Max Boring Depth is defined on the tool.

Axial Limit for Chuck Jaws (for external or frontal machining): Offset defined from the machining axis system. 

Machining Strategy Parameters for Rough Turning

Path Definition for Rough Turning

●     Machining tolerance

●     Max Depth of Cut
This option is used to specify the maximum distance between passes.
It is replaced by Radial Depth of Cut and Axial Depth of Cut for Parallel Contour Rough Turning.

●     Leading and Trailing Safety Angles
The insert geometry is taken into account to avoid collision by reducing the maximum slope on which the tool 
can machine. The Leading Safety Angle and Trailing Safety Angle allow you to further reduce the area to 
machine. 
Note that Trailing Angle can be used only when Recess Machining is set. 

Leading and trailing angles can also be defined on the insert-holder to define the maximum slope on which 
machining can be done. In this case and if the Insert-Holder Constraints setting is applied (see above), the 
angles that reduce the slope the most will be taken into account.

●     Part Contouring 
You can specify a contouring type for longitudinal and face Rough Turning in order to clear the part profile by 
means of the following settings: 

❍     No: no contouring

❍     Each path: profile following at each roughing pass

❍     Last path only: profile following at last roughing pass only.

●     Under Spindle Axis Machining
For Face and Parallel Contour Rough Turning with Frontal machining, this option allows you to request 
machining under the spindle axis.

●     Machining Direction (only for Parallel Contour and Face Rough Turning with Frontal machining) 



You can specify the machining direction with respect to the spindle axis by means of the To/From Spindle Axis 
choice.

●     Recess Machining (if Contouring Type is Each Pass or Last Path Only) 
If you require recess machining, activate this checkbox.
When recess machining is active in Parallel Contour Rough Turning, Axial and Radial Depth of Cut must have 
suitable values to ensure a collision free toolpath. See Recommendations below.

The following options are proposed for recess machining:

●     Plunge Distance and Plunge Angle (for longitudinal and face Rough Turning)
Define the plunge vector before each new pass with respect to the cutting direction.

 

Example of Recess with External Longitudinal Rough Turning

In the figure above the tool motion is as follows:

●     approach in RAPID mode

●     lead-in at the first recess pass and plunge approach for other passes

●     plunge at plunge feedrate

●     machine at machining feedrate

●     contouring at contouring feedrate

●     lift-off at last recess pass at lift-off feedrate.

Note that Trailing angle is defined on the tool.

Recommendations for Collision Free Recess Machining in Parallel Contour Rough Turning



Machining in Parallel Contour Rough Turning is done by means of successive offsets of the toolpath: the offset 
depends on the axial and radial depth of cut values.
The following recommendations describe how to set the axial and radial depth of cuts to ensure a collision free 
toolpath. 

Parallel contour principle:
The parallel contours of the toolpath are obtained by first shifting the last pass then shifting each successive pass 
depending on the axial and radial depth of cut values.

Then the passes are relimited taking into account the stock definition.

Correct combination of axial and radial depth of cuts
Compared with the left and right angles on the insert, the axial and radial depth of cut values define a shift 
direction that must be compatible with the insert. 

The shift direction must be inside the limit angles defined on the tool insert otherwise a collision may occur. In 
collision cases, the collision is on the first pass, not on the last passes of the toolpath.

Example of a correct combination



Example of an incorrect combination (right of tool)

The parallel contour toolpath is in collision because the shift does not respect the tool insert angle on the right side.

Lead-in, Lift-off and Attack for Rough Turning

These options allow penetration into the workpiece at a reduced feedrate in order to prevent tool damage. Once the 
attack distance has been run through, the tool moves at machining feedrate.



●     Lead-in Distance and Lead-in Angle
These parameters define the lead-in vector at the start of each pass with respect to the normal to the cutting 
direction.

Lead-in distance takes the stock profile and stock clearance into account. The tool is in RAPID mode 
before this distance.

If no lead-in angle is requested, the lead-in path is normal to the cutting direction. 
For Longitudinal and Face Rough Turning the lead-in angle can be applied as follows: 

●     no angle applied to lead-in path

●     lead-in angle applied to each path

●     lead-in angle applied to last path only.

●     Attack Distance
Defined with respect to the cutting direction and takes the stock profile and stock clearance into account.

 

●     Lift-off Distance and Lift-off Angle
These parameters define the lift-off vector at the end of each pass with respect to the cutting direction.



 

For Longitudinal or Face Rough Turning, lift-off occurs:

●     at the end of each pass when Contouring Type is set to None or Last Path Only.

●     At the end of the last pass of the operation when the contouring type is set to Each Path. This prevents the tool 
from damaging the part when returning to the end point in RAPID mode.

●     at the end of each pass that ends on the stock profile.

For Parallel Contour Rough Turning, lift-off occurs when the end of the pass has already been machined by a 
previous pass.

Feeds and Speeds for Rough Turning

Speed unit can be set to: 

●     Angular: spindle speed in revolutions per minute

●     Linear: constant cutting speed in units per minute

then you can give a Machining Speed value. 

Available feedrates in units per revolution are as follows:

●     Machining Feedrate

●     Lead-in Feedrate which is applied during the lead-in and attack distance

●     Lift-off Feedrate

●     Contouring Feedrate (if contouring type is Each Path or Last Path Only)

●     Plunge Feedrate (for longitudinal and face Rough Turning).

Feedrates in units per minute are also available for air cutting such as macro motions and path transitions. 
Note that RAPID feedrate can be replaced by Air Cutting feedrate in tool trajectories (except in macros) by 

selecting the checkbox in the Feed and Speeds tab page .

Dwell setting indicates whether the tool dwell at the end of each path is to be set in seconds or a number of spindle 



revolutions.

Please note that decimal values can be used for the number of revolutions. For example, when machining big parts 
that have a large volume, it can be useful to specify a dwell using a value of less than one revolution (0.25, for 
example).

Tool Compensation for Rough Turning  

You can select a tool compensation number corresponding to the desired tool output point. Note that the usable 
compensation numbers are defined on the tool assembly linked to the machining operation. If you do not select a 
tool compensation number, the output point corresponding to type P9 will be used by default.

Approach, Retract and Linking Macros for Rough Turning

The following Approach and Retract macro modes are proposed: Direct, Axial-radial, Radial-axial, and Build by 
user. 
The selected macro type (Approach or Retract) defines the tool motion before or after machining. Various feedrates 
are available for the approach and retract motions (RAPID, lead-in, lift-off, and so on). 

   

Linking macros, which comprise retract and approach motion can also be used on Rough Turning operations. 
Approach and retract motions of linking macros are interruptible. It can be useful to interrupt an operation when 
the foreseeable lifetime of the insert is not long enough to complete the machining.

See Define Macros on a Turning Operation for more information.
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Recess Turning Operations
The information in this section will help you create and edit Recess Turning operations in your 
manufacturing program. 

The Recess Turning operation allows you to machine a recess by means of a One Way, Zig Zag or Parallel 
Contour tool motion.  

 

You can specify:

●     external, internal, frontal or inclined machining according to the type of area to machine

●     various approach and retract path types

●     various lead-in and lift-off options with specific feedrates

●     part contouring

●     tool output point change.

The following topics are dealt with in the paragraphs below:

●     Tooling

●     Geometry

●     Machining Strategy Parameters

●     Feeds and Speeds

●     Tool Compensation



●     Macros.

Tooling for Recess Turning

The following tooling may be used: 

●     External and Internal insert-holders with all insert types except groove and thread. 

●     Internal, External and Frontal Groove insert-holders with groove inserts. 

Note that the following attributes may influence machining (they are located on the Insert-holder's 
Technology tab):

●     Gouging angle

●     Trailing angle

●     Leading angle

●     Max Recessing Depth

●     Max Cutting Depth

●     Max Boring Depth.

These attributes take tooling accessibility into account and may reduce the machined area.
However, you can use the Insert-Holder Constraints option on the operation editor to either ignore or 
apply these tooling attributes. You can replay the operation to verify the influence of these attributes on 
the generated tool path.

Note that the Insert-Holder Constraints setting does not influence the Gouging Safety Angle or the 
Leading and Trailing Safety Angles defined in the operation editor.

Geometry for Recess Turning

Part and Stock profiles are required. They can be specified as follows:

●     select edges either directly or after selecting the By Curve contextual command. In this case the Edge 
Selection toolbar appears to help you specify the guiding contour.

●     select the Sectioning contextual command. Please refer to Sectioning for details of how to use this 
capability.
Please note that the sectioning selection method is not associative.

Orientation for Recess Turning

The following Orientations are proposed: internal, external, frontal and inclined. 

The selected Orientation defines the type of geometric relimitation to be done between the stock and part 
geometry in order to determine the area to machine. For an inclined orientation you must specify the 
Angle of Incline. 

Part and Stock Offsets for Recess Turning
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●     Stock offset, which is defined perpendicular to the stock profile

●     Part offset, which is defined perpendicular to the part profile.

●     Axial part offset 

●     Radial part offset.

Offsets can be positive or negative with any absolute value. The global offset applied to the part profile is 
the resulting value of the normal, axial and radial offsets. 

Machining Strategy Parameters for Recess Turning

Path Definition for Recess Turning

●     Recess Turning Mode: One Way, Zig Zag or Parallel Contour

●     Max Depth of Cut
This option is used to specify the maximum distance between passes.
Axial and Radial Depth of Cut
These options are used to specify the maximum axial and radial distances between passes for Parallel 
Contour mode.

●     Machining Tolerance

●     Machining Direction 
For Zig Zag tool motion, you must specify a first cutting direction as follows: 

❍     To or From Head Stock for Internal and External machining

❍     To or From Spindle for Frontal machining

❍     To Right or Left of Recess for Inclined machining

When a part profile has multiple recesses (that is, a non-convex profile along the cutting direction), 
only the first recess along the specified direction is machined.

●     Leading and Trailing Safety Angles for One way and Parallel Contour modes
The insert geometry is taken into account to avoid collision by reducing the maximum slope on which 
the tool can machine. The Leading and Trailing Safety Angles allow you to further reduce this slope. 

Leading and trailing angles can also be defined on the insert-holder to define the maximum slope on 
which machining can be done. In this case and if the Insert-Holder Constraints setting is applied 
(see above), the angles that reduce the slope the most will be taken into account.

●     Gouging Safety Angle (for Zig Zag mode only)
Angles of the insert are taken into account to avoid collision by reducing the maximum slope on which 
the tool can machine. The Gouging Safety Angle allows you to further reduce this slope. 

Note that a gouging angle can also be defined on the insert-holder to define the maximum slope on 
which the tool can machine. In this case and if the Insert-Holder Constraints setting is applied (see 
above), the angle that reduces the slope the most will be taken into account.

●     Under Spindle Axis Machining
For Frontal or Inclined machining, this option allows you to request machining under the spindle axis.

●     Part Contouring
You can specify if contouring is required by means of the proposed checkbox.
The part profile is followed at the end of Recess Turning. This is done by machining down the sides of 
the recess in order to clear the profile.



 

Lead-in, Lift-off and Attack for Recess Turning

●     Lead-in Distance
Defined with respect to the cutting direction. It takes the stock profile and stock clearance into 
account. The tool is in RAPID mode before this distance.

●     Attack Distance
Defined with respect to the cutting direction and the stock profile with a stock clearance.

●     Angle and Distance before Plunge
Define the plunge vector before each new pass with respect to the cutting direction.

●     Lift-off Distance and Lift-off Angle
Define the lift-off vector at the end of the last pass with respect to the cutting direction. The figure 
below shows the effect of a positive lift-off angle (external machining is assumed).

 



Feeds and Speeds for Recess Turning

Speed unit can be set to: 

●     Angular: spindle speed in revolutions per minute

●     Linear: constant cutting speed in units per minute

then you can give a Machining Speed value. 

Available feedrates in units per revolution are as follows:

●     Machining Feedrate

●     Lead-in Feedrate, which is applied during the lead-in and attack distance.

●     Lift-off Feedrate

●     Contouring Feedrate

●     Plunge Feedrate.

Feedrates in units per minute are also available for air cutting such as macro motions and path transitions. 
Note that RAPID feedrate can be replaced by Air Cutting feedrate in tool trajectories (except in macros) by 

selecting the checkbox in the Feed and Speeds tab page .

Dwell setting indicates whether the tool dwell at the end of each path is to be set in seconds or a number 
of spindle revolutions.

Please note that decimal values can be used for the number of revolutions. For example, when machining 
big parts that have a large volume, it can be useful to specify a dwell using a value of less than one 
revolution (0.25, for example).

Example of one-way Recess Turning. Note that Trailing angle is defined on the tool.  

In the figure below the tool motion is as follows:

●     approach in RAPID mode

●     lead-in at the first recess pass and plunge approach for other passes

●     plunge at plunge feedrate

●     machine at machining feedrate

●     contouring at contouring feedrate

●     lift-off at last recess pass at lift-off feedrate.



Tool Compensation for Recess Turning

You can select a tool compensation number corresponding to the desired tool output point. Note that 
the usable compensation numbers are defined on the tool assembly linked to the machining operation. If 
you do not select a tool compensation number, the output point corresponding to type P9 will be used by 
default.

Note that the change of output point is managed automatically if you set the Change Output Point 
option. 

If the output point is consistent with the flank of the recess to be machined, the output point is changed 
when the other flank of the recess is machined.

At the end of the operation, the output point is the same as it was at the start of the operation. See 
Changing the Output Point for more information.

Approach, Retract and Linking Macros for Recess Turning

The following Approach and Retract macro modes are proposed: Direct, Axial-radial, Radial-axial, and 
Build by user. The selected macro type (Approach or Retract) defines the tool motion before or after 
machining. Various feedrates are available for the approach and retract motions (RAPID, lead-in, lift-off, 
and so on).

Linking macros, which comprise retract and approach motion can also be used on Recess Turning 
operations.
Approach and retract motions of Linking macros are interruptible. It can be useful to interrupt an operation 
when the foreseeable lifetime of the insert is not long enough to complete the machining.



See Define Macros on a Turning Operation for more information.
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Groove Turning Operations
The information in this section will help you create and edit Groove Turning operations in your 
manufacturing program. 

The Groove Turning operation allows you to machine a groove by a series of plunging cuts. You can specify: 

●     external, internal, frontal or inclined machining according to the type of area to machine

●     various approach and retract path types

●     various lead-in and lift-off options with specific feedrates

●     various plunge locations

●     tool output point change.

The following topics are dealt with in the paragraphs below:

●     Tooling

●     Geometry

●     Machining Strategy Parameters

●     Feeds and Speeds

●     Tool Compensation

●     Macros.

Tooling for Groove Turning

The following tooling may be used: 

●     Internal, External and Frontal Groove insert-holders with groove inserts. 

●     External and Internal insert-holders with round inserts.

Note that the following attributes may influence machining (they are located on the Insert-holder's 
Technology tab):

●     Gouging angle

●     Trailing angle

●     Leading angle

●     Max Recessing Depth

●     Max Cutting Depth

●     Max Boring Depth.

These attributes take tooling accessibility into account and may reduce the machined area.
However, you can use the Insert-Holder Constraints option on the operation editor to either ignore or 
apply these tooling attributes. You can replay the operation to verify the influence of these attributes on the 
generated tool path.



Note that the Insert-Holder Constraints setting does not influence the Gouging Safety Angle or Max 
Depth of Cut defined in the operation editor.

Geometry for Groove Turning

Part and Stock profiles are required. They can be specified as follows:

●     select edges either directly or after selecting the By Curve contextual command. In this case the Edge 
Selection toolbar appears to help you specify the guiding contour.

●     select the Sectioning contextual command. Please refer to Sectioning for details of how to use this 
capability.
Please note that the sectioning selection method is not associative.

Orientation for Groove Turning 

The following Orientations are proposed: internal, external, frontal and inclined. The selected Orientation 
defines the type of geometric relimitation to be done between the stock and part geometry in order to 
determine the area to machine. For an inclined orientation you must specify the Angle of Incline.

Part and Stock Offsets for Groove Turning

●     Stock offset, which is defined perpendicular to the stock profile

●     Part offset, which is defined perpendicular to the part profile.

●     Axial part offset 

●     Radial part offset.

Offsets can be positive or negative with any absolute value. The global offset applied to the part profile is 
the resulting value of the normal, axial and radial offsets. 

Machining Strategy Parameters for Groove Turning

Path Definition for Groove Turning

●     Max Depth of Cut
This option is used to specify the maximum distance between plunges.

●     First Plunge 
You must specify a first plunge position according to the groove orientation by means of the following 
choice: Left/Down - Center - Right/Up - Automatic. 
Automatic is only available for frontal machining. In this case, the position of the first plunge is deduced 
from the tool's minimum and maximum cut diameters. The position is at a distance:
(Minimum cut radius + Maximum cut radius)/2.

●     Next Plunges (if First Plunge is set to Center).
You can specify the position of the plunges that follow the first plunge with respect to: 

❍     the spindle axis by means of the To or From Spindle for frontal machining

❍     the head stock by means of the To or From Head Stock for internal or external machining

❍     the groove by means of Left or Right of Groove for Inclined machining.
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●     Part Contouring
You can specify if contouring is required by means of the proposed checkbox.
The part profile is followed at the end of grooving. This is done by machining down the sides of the 
groove in order to clear the profile.

●     Grooving by Level mode
This option allows you to machine the groove in one or more level. 
Multiple-levels mode is particularly useful when the groove is too deep to machine in one level. In this 
case Maximum grooving depth defines the maximum depth of each level. If it is greater than the 
Maximum Depth of Cut defined on the tool, the value on the tool is taken into account.

●     Under Spindle Axis Machining
When Groove Turning in frontal mode, this option allows you to request machining under the spindle 
axis.

●     Chip Break
You can specify if chip clearing is to be done during machining by setting the check box. In this case you 
must specify Plunge, Retract and Clear distances.

●     Gouging Safety Angle
Angle attributes on the grooving insert are taken into account to avoid collision by reducing the 
maximum slope on which the tool can machine. The Gouging Safety Angle allows you to further reduce 
this slope. 

Note that a gouging angle can also be defined on the insert-holder to define the maximum slope on 
which the tool can machine. In this case and if the Insert-Holder Constraints setting is applied (see 
above), the angle that reduces the slope the most will be taken into account.

●     Machining Tolerance.

Lead-in, Lift-off and Attack for Groove Turning

●     Lead-in Distance
Defined with respect to the cutting direction. It takes the stock profile and stock clearance into account. 
The tool is in RAPID mode before this distance.

●     Attack Distance
Defined with respect to the cutting direction and the stock profile with a stock clearance.

These options allow penetration into the workpiece at a reduced feedrate in order to prevent tool 
damage. Once the attack distance has been run through, the tool moves at machining feedrate.

When tool motion between two passes is in contact with the part profile, in order to avoid 
collisions the corresponding feed is the lift-off feedrate and not RAPID. 

●     Lift-off Distance and Lift-off Angle
These parameters define the lift-off vector at the end of each pass with respect to the cutting direction. 
The figure below shows the effect of a positive lift-off angle (external machining is assumed).



Feeds and Speeds for Groove Turning

Speed unit can be set to: 

●     Angular: spindle speed in revolutions per minute

●     Linear: constant cutting speed in units per minute

then you can give a Machining Speed value. 

Available feedrates in units per revolution are as follows:

●     Contouring Feedrate

●     Lead-in Feedrate, which is applied during lead-in and attack distances

●     Lift-off Feedrate

●     First Plunge Feedrate and Next Plunges Feedrate. 
Different feedrates can be assigned to the first plunge and the following plunges.

Feedrates in units per minute are also available for air cutting such as macro motions and path transitions. 
Note that RAPID feedrate can be replaced by Air Cutting feedrate in tool trajectories (except in macros) by 

selecting the checkbox in the Feed and Speeds tab page .

Dwell setting indicates whether the tool dwell at the end of a path or a plunge is to be set in seconds or a 
number of spindle revolutions.

Please note that decimal values can be used for the number of revolutions. For example, when machining 
big parts that have a large volume, it can be useful to specify a dwell using a value of less than one 
revolution (0.25, for example).

Tool Compensation for Groove Turning 



You can select a tool compensation number corresponding to the desired tool output point. Note that the 
usable compensation numbers are defined on the tool assembly linked to the machining operation. If you 
do not select a tool compensation number, the output point corresponding to type P9 will be used by 
default. 

Note that the change of output point is managed automatically if you set the Change Output Point option. 
If the output point is consistent with the flank of the groove to be machined, the output point is changed 
when the other flank of the groove is machined.
At the end of the operation, the output point is the same as it was at the start of the operation. See 
Changing the Output Point for more information.

Approach, Retract and Linking Macros for Groove Turning

The following Approach and Retract macro modes are proposed: Direct, Axial-radial, Radial-axial, and Build 
by user.
The selected macro type (Approach or Retract) defines the tool motion before or after machining. Various 
feedrates are available for the approach and retract motoins (RAPID, lead-in, lift-off, and so on).

Linking macros, which comprise retract and approach motion can also be used on Groove Turning 
operations.
Approach and retract motoins of linking macros are interruptible. It can be useful to interrupt an operation 
when the foreseeable lifetime of the insert is not long enough to complete the machining.

See Define Macros on a Turning Operation for more information.
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Profile Finish Turning Operations
The information in this section will help you create and edit Profile Finish Turning operations in your manufacturing program. 

The Profile Finish Turning operation allows you to finish a part profile. You can specify: 

●     the type of machining according to the profile of the area to machine (external, internal or frontal)

●     relimitation of the profile by start and end elements

●     various approach and retract path types

●     linear and circular lead-in and lift-off options with specific feedrates

●     recess machining

●     various corner processing options

●     cutter compensation.

The following topics are dealt with in the paragraphs below:

●     Tooling

●     Geometry

●     Machining Strategy Parameters

●     Feeds and Speeds

●     Tool Compensation

●     Macros.

Tooling for Profile Finish Turning 

The following tooling may be used: 

●     External and Internal insert-holders with all insert types except groove and thread. 

●     External and Internal Groove insert-holders with groove inserts. 

Note that the following attributes may influence machining (they are located on the Insert-holder's Technology tab):

●     Gouging angle

●     Trailing angle

●     Leading angle

●     Max Recessing Depth

●     Max Cutting Depth

●     Max Boring Depth.

These attributes take tooling accessibility into account and may reduce the machined area.
However, you can use the Insert-Holder Constraints option on the operation editor to either ignore or apply these tooling attributes. You can 
replay the operation to verify the influence of these attributes on the generated tool path.

Note that the Insert-Holder Constraints setting does not influence the Leading and Trailing Safety Angles defined in the operation editor.

Geometry for Profile Finish Turning 

A Part profile is required. It can be specified as follows:

●     select edges either directly or after selecting the By Curve contextual command. In this case the Edge Selection toolbar appears to help you 
specify the guiding contour.

●     select the Sectioning contextual command. Please refer to Sectioning for details of how to use this capability.
Please note that the sectioning selection method is not associative.

Start Limit: None / In / On / Out
This option allows you to specify a point, line, curve or face as the start element of the part profile. If a face is specified, the start element is the 
intersection of the face and the working plane. The position of the start of machining is also defined with respect to this element.
In / On / Out: allows you to specify the Go-Go type positioning of the tool with respect to the start element. The On option is always used for a 
point type start element.
If needed, the profile may be extrapolated to the start element.
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End Limit: None / In / On / Out
This option allows you to specify a point, line, curve or face as the end element of the part profile. If a face is specified, the end element is the 
intersection of the face and the working plane. The position of the end of machining is also defined with respect to this element.  
In / On / Out: allows you to specify the Go-Go type positioning of the tool with respect to the end element. The On option is always used for a 
point type end element.

Relimiting the area to machine by means of limit elements

If you specify a point, it is projected onto the part profile. 
A line through the projected point parallel to the radial axis delimits the area to machine.

If you specify a line, its intersection with the part profile is calculated (if necessary, the line is extrapolated). 
A line through the intersection point parallel to the radial axis delimits the area to machine.

If you specify a curve, its intersection with the part profile is calculated (if necessary, the curve is extrapolated using the tangent at the curve 
extremity). 
A line through the intersection point parallel to the radial axis delimits the area to machine.

If needed, the profile may be extrapolated to the end element. 

 

The figure above illustrates the use of start and end elements for Profile Finish Turning. Profile is machined from start element. Profile is 
extrapolated up to end element. Direct approach and radial-axial retract.

Orientation and Location for Profile Finish Turning

●     Orientation: Internal / External / Frontal
This option allows you to specify the type of machining according to the location of the area to machine on the part.

●     Location:  
❍     Front, the profile is machined toward the head stock

❍     Back, the profile is machined from the head stock.

Corner Processing for Profile Finish Turning 

The following options allow you to define how corners of the profile are to be machined:

●     None: no corners are to be machined along the profile

●     Chamfer: only 90 degree corners of the profile are chamfered

●     Rounded: all corners of the profile are rounded.



 

Corner processing options are also available to define how the entry and exit corners are to be machined. Entry and exit corners are defined by 
either a chamfer length, or a corner radius and corner angle.

Part Offsets for Profile Finish Turning

●     Part offset, which is defined perpendicular to the part profile.

●     Axial part offset.

●     Radial part offset.

●     Start limit offset: distance with respect to the start element (only if start element is a line or a curve, and when In or Out is set for start 
element positioning).

●     End limit offset: distance with respect to the end element (only if end element is a line or a curve, and when In or Out is set for end 
element positioning).

Offsets can be positive or negative with any absolute value. The global offset applied to the part profile is the resulting value of the normal, axial 
and radial offsets. 

In addition to these global values, local offsets can be applied to segments, curves and arcs of the part profile. 

Machining Strategy Parameters for Profile Finish Turning

Path Definition for Profile Finish Turning

●     Machining Direction: To or From Spindle
This option is only available for frontal machining for specifying the machining direction with respect to the spindle axis.

If start and end elements are defined that are in conflict with the machining direction, then these elements will be reversed 
automatically. 

●     Contouring for Outside Corners: Angular / Circular
Allows you to define whether angular or circular contouring is to be applied to corners of the profile (only if corner processing is set to 
Rounded or Chamfer).



 

●     Under Spindle Axis Machining
When finishing in frontal mode, this option allows you to request machining under the spindle axis.

●     Recess Machining
When this option is set, a recess machining path is done after the profile finish path.
The trailing safety angle option becomes available.

●     Leading and Trailing Safety Angles
The insert geometry is taken into account to avoid collision by reducing the maximum slope on which the tool can machine. The Leading 
Safety Angle and Trailing Safety Angle allow you to further reduce this slope. 

Leading and trailing angles can also be defined on the insert-holder to define the maximum slope on which machining can be done. In this 
case and if the Insert-Holder Constraints setting is applied (see above), the angles that reduce the slope the most will be taken into 
account.

●     Machining Tolerance for following the profile.

Lead-in and Lift-off for Profile Finish Turning

●     Lead-in type: Linear / Circular  
Defines the type of lead-in onto the profile at lead-in feedrate 

❍     Linear: lead-in up to the point where profile machining starts is defined by means of the lead-in distance and lead-in angle 
parameters. 

❍     Circular: lead-in is circular and tangent to the point where profile machining starts. It is defined by means of the lead-in radius and lead-
in angle parameters.

 Note that the lead-in angle is defined with respect to the normal to the cutting direction.

The figure below shows an example of linear lead-in and circular lift-off (external machining is assumed).



 

●     Lift-off type: Linear / Circular.
 Defines the type of lift-off from the profile at lift-off feedrate 

❍     Linear: lift-off from the point where profile machining ends is defined by means of the lift-off distance and lift-off angle parameters.

❍     Circular: lift-off is circular and tangent from the point where profile machining ends. It is defined by means of the lift-off radius and lift-
off angle parameters.

 Note that the lift-off angle is defined with respect to the normal to the cutting direction.

In the example below, the round tool is tangent In start element plus clearance at start of profiling. Round tool is tangent Out end element plus 
clearance at end of profiling.

Local Invert

Invert strategy

●     None: no Invert Strategy

●     Overlap: defined by a clearance and a overlap parameter.

●     Thickness: defined by a clearance and a thickness parameter.

Machine inverted elements first: you machine inverted elements the first path, and then the other elements.

Lead-in Angle and Distance or Radius for entry path.
Lift-off Angle and Distance or Radius for exit path.



Lift-off type allows to select the type of entry and exit motion between Linear and Circular.
Linear motion is defined by a distance and an angle.
Circular motion is defined by a radius and an angle.

Feeds and Speeds for Profile Finish Turning

Speed unit can be set to: 

●     Angular: spindle speed in revolutions per minute

●     Linear: constant cutting speed in units per minute

then you can give a Machining Speed value. 

Available feedrates in units per revolution are as follows:

●     Machining Feedrate

●     Chamfering Feedrate for machining chamfers or corners

●     Lift-off Feedrate

●     Lead-in Feedrate.

In addition to these global feedrates, local feedrates can be applied to segments, curves and arcs of the part profile.

Feedrates in units per minute are also available for air cutting such as macro motions and path transitions. 
Note that RAPID feedrate can be replaced by Air Cutting feedrate in tool trajectories (except in macros) by selecting the checkbox in the Feed 

and Speeds tab page .

Tool Compensation for Profile Finish Turning 

You can select a tool compensation number corresponding to the desired tool output point. Note that the usable compensation numbers are 
defined on the tool assembly linked to the machining operation. If you do not select a tool compensation number, the output point corresponding 
to type P9 will be used by default. 

CUTCOM (Cutter Compensation): None / On / Reverse. 
If this option is set to On or Reverse, the NC output will include CUTCOM instructions in approach and retract paths for cutter compensation.

●     On: CUTCOM/RIGHT instruction generated if tool is to the right of the toolpath and CUTCOM/LEFT if tool is to the left of the toolpath.

●     Reverse: CUTCOM/RIGHT instruction generated if tool is to the left of the toolpath and CUTCOM/LEFT if tool is to the right of the toolpath.

See Cutter Compensation with Finish Operations for more information. 

Approach and Retract Macros for Profile Finish Turning

The following Approach and Retract macros are proposed: Direct, Axial-radial, Radial-axial, and Build by user.
The selected macro type (Approach or Retract) defines the tool motion before or after machining: Various feedrates are available for the 
approach and retract motions (RAPID, lead-in, lift-off, and so on).

See Define Macros on a Turning Operation for more information.
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Groove Finish Turning Operations
The information in this section will help you create and edit Groove Finish Turning operations in your 
manufacturing program. 

The Groove Finish Turning operation allows you to finish a groove by means of downward profile following. You 
can specify: 

●     the type of machining according to the groove profile to be machined (external, internal, frontal or inclined)

●     relimitation of the profile by start and end elements

●     various approach and retract path types

●     linear and circular lead-in and lift-off options with specific feedrates

●     various corner processing options with specific feedrates

●     local feedrates for individual elements of the machined profile

●     tool output point change

●     cutter compensation.

The following topics are dealt with in the paragraphs below:

●     Tooling

●     Geometry

●     Machining Strategy Parameters

●     Feeds and Speeds

●     Tool Compensation

●     Macros.

Tooling for Groove Finish Turning 

The following tooling may be used: 

●     Internal, External and Frontal Groove insert-holders with groove inserts. 

●     External and Internal insert-holders with round inserts.

Note that the following attributes may influence machining (they are located on the Insert-holder's Technology 
tab):

●     Gouging angle

●     Trailing angle

●     Leading angle

●     Max Recessing Depth

●     Max Cutting Depth

●     Max Boring Depth.

These attributes take tooling accessibility into account and may reduce the machined area.



However, you can use the Insert-Holder Constraints option on the operation editor to either ignore or apply 
these attributes. You can replay the operation to verify the influence of these attributes on the generated tool 
path.

Geometry for Groove Finish Turning

The Part profile (that is, the groove finish profile) is required. It can be specified as follows:

●     select edges either directly or after selecting the By Curve contextual command. In this case the Edge 
Selection toolbar appears to help you specify the guiding contour.

●     select the Sectioning contextual command. Please refer to Sectioning for details of how to use this 
capability.
Please note that the sectioning selection method is not associative.

Start Limit: None / In / On / Out
This option allows you to specify a point, line, curve or face as the start element of the groove finish profile. The 
position of the start of machining is also defined with respect to this element. If a face is specified, the start 
element is the intersection of the face and the working plane. If needed, the profile may be extrapolated to the 
start element.

In / On / Out allows you to specify the Go-Go type positioning of the tool with respect to the start element. The 
On option is always used for a point type start element.

End Limit: None / In / On / Out
This option allows you to specify a point, line, curve or face as the end element of the groove finish profile. If a 
face is specified, the end element is the intersection of the face and the working plane. The position of the end 
of machining is also defined with respect to this element. If needed, the profile may be extrapolated to the end 
element.

In / On / Out allows you to specify the Go-Go type positioning of the tool with respect to the end element. The 
On option is always used for a point type start element.

Relimiting the area to machine by means of limit elements

If you specify a point, it is projected onto the part profile. 
A line through the projected point parallel to the radial axis delimits the area to machine.

If you specify a line, its intersection with the part profile is calculated (if necessary, the line is extrapolated). 
A line through the intersection point parallel to the radial axis delimits the area to machine.

If you specify a curve, its intersection with the part profile is calculated (if necessary, the curve is extrapolated 
using the tangent at the curve extremity). 
A line through the intersection point parallel to the radial axis delimits the area to machine.

Orientation for Groove Finish Turning

●     Orientation: Internal / External / Frontal / Inclined
This option allows you to define the orientation of the groove to be machined.

For an inclined orientation you must specify the Angle of Incline. 

Corner Processing for Groove Finish Turning 

The following options allow you to define how corners of the profile are to be machined:
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●     Follow profile: no corners are to be machined along the profile

●     Chamfer: only 90 degree corners of the profile are chamfered

●     Rounded: all corners of the profile are rounded.

Corner processing is proposed for Entry, Exit and Other corners.

●     Chamfer Length if Other corner processing mode is Chamfer.

●     Corner Radius if Other corner processing mode is Rounded.

●     Entry Corner Chamfer Length on first flank of groove when Entry corner processing mode is Chamfer

●     Entry Corner Radius on first flank of groove when Entry corner processing mode is Corner

●     Entry Corner Angle on first flank of groove when Entry corner processing mode is Corner

●     Exit Corner Chamfer Length on last flank of groove when Exit corner processing mode is Chamfer

●     Exit Corner Radius on last flank of groove when Exit corner processing mode is Corner

●     Exit Corner Angle on last flank of groove when Exit corner processing mode is Corner.

Part Offsets for Groove Finish Turning

●     Part offset, which is defined perpendicular to the part profile.

●     Axial part offset.

●     Radial part offset.

●     Start limit offset: distance with respect to the start element (only if start element is a line or a curve, and 
when In or Out is set for start element positioning).

●     End limit offset: distance with respect to the end element (only if end element is a line or a curve, and 
when In or Out is set for end element positioning).

Offsets can be positive or negative with any absolute value. The global offset applied to the part profile is the 
resulting value of the normal, axial and radial offsets. In addition to these global offsets, local values can be 
applied to segments, curves and arcs of the part profile.

Machining Strategy Parameters for Groove Finish Turning

Path Definition for Groove Finish Turning

●     Machining Direction
You can specify the machining direction by means of: 

❍     To or From Head for Internal and External machining

❍     To or  From Spindle for Frontal machining

❍     To Right or Left of Groove for Inclined machining

If start and end elements are defined that are in conflict with the machining direction, then these 
elements will be reversed automatically. 

●     Clearance: this value defines the clearance to be applied to the next flank after the first machined flank. 
The bottom of the groove will be machined up to the position defined by this clearance value.

●     Tool Overlap Distance on Groove Bottom.



●     Under Spindle Axis Machining
When finishing in frontal mode, this option allows you to request machining under the spindle axis.

●     Contouring for Outside Corners: Angular / Circular
Allows you to define whether an angle or circle contouring mode is to be applied to corners of the groove 
profile (only if corner processing is set to None or Chamfer).

●     Machining Tolerance for following the groove finish profile.

Lead-in for Groove Finish Turning

●     First Flank Lead-in: Linear / Circular

Defines the type of lead-in at lead-in feedrate on the first flank of the groove. 

●     Linear: lead-in up to the point where first flank machining starts is defined by means of the first 
lead-in distance and first lead-in angle parameters.

●     Circular: lead-in is circular and tangent to the point where first flank machining starts. It is defined 
by means of the first lead-in radius and first lead-in angle parameters.

 Note that the first lead-in angle is defined with respect to the normal to the cutting direction. The 
figure below shows the effect of a positive first lead-in angle (external machining is assumed).

●     Last Flank Lead-in: Linear / Circular  
Defines the type of lead-in at lead-in feedrate on the last flank of the groove. 

❍       Linear: lead-in up to the point where last flank machining starts is defined by means of the last lead-in 
distance and last lead-in angle parameters. 

❍     Circular: lead-in is circular and tangent to the point where last flank machining starts. It is defined by 
means of the last lead-in radius and last lead-in angle parameters.

 Note that the last lead-in angle is defined with respect to the normal to the cutting direction. The figure 
below shows the effect of a positive last lead-in angle (external machining is assumed).



●     Other Flank Lead-in: Linear / Circular
For a groove that has multiple recesses, this option defines the type of lead-in required to machine flanks 
other than the first and last flanks.

●     Other Lead-in Distance on other flanks of the groove when other flank lead-in type is Linear

●     Other Lead-in Angle on other flanks of the groove when other flank lead-in type is Linear or 
Circular

●     Other Lead-in Radius on other flanks of the groove when other flank lead-in type is Circular.

 Note that the other lead-in angle is defined with respect to the cutting direction.

Lift-off for Groove Finish Turning

●     Lift-off Type: Linear / Circular

Defines the type of lift-off from the groove at lift-off feedrate. 

●     Lift-off Distance when lift-off type is Linear.

●     Lift-off Angle when lift-off type is Linear or Circular.

●     Lift-off Radius when lift-off type is Circular.

 Note that the lift-off angle is defined with respect to the normal to the cutting direction. The figure 
below shows the effect of a positive lift-off angle (external machining is assumed).



The example below shows Linear lead-in and Circular lift-off for Groove Finish Turning.

 



Feeds and Speeds for Groove Finish Turning

Speed unit can be set to: 

●     Angular: spindle speed in revolutions per minute

●     Linear: constant cutting speed in units per minute

then you can give a Machining Speed value. 

Available feedrates in units per revolution are as follows:

●     Machining Feedrate  

●     Chamfering Feedrate for machining chamfers or corners

●     Lift-off Feedrate  

●     Lead-in Feedrate.

In addition to these global feedrates, local feedrates can be applied to segments, curves and arcs of the part 
profile.

Feedrates in units per minute are also available for air cutting such as macro motions and path transitions. 
Note that RAPID feedrate can be replaced by Air Cutting feedrate in tool trajectories (except in macros) by 

selecting the checkbox in the Feed and Speeds tab page .

Tool Compensation for Groove Finish Turning 

You can select a tool compensation number corresponding to the desired tool output point. Note that the 
usable compensation numbers are defined on the tool assembly linked to the machining operation. If you do not 
select a tool compensation number, the output point corresponding to type P9 will be used by default. 

CUTCOM (Cutter Compensation): None / On / Reverse
If this option is set to On or Reverse, the NC output will include CUTCOM instructions in approach and retract 
paths for cutter compensation.

●     On: CUTCOM/RIGHT instruction generated if tool is to the right of the toolpath and CUTCOM/LEFT if tool is to 
the left of the toolpath.

●     Reverse: CUTCOM/RIGHT instruction generated if tool is to the left of the toolpath and CUTCOM/LEFT if tool 
is to the right of the toolpath.

See Cutter Compensation with Finish Operations for more information.  

Note that the change of output point is managed automatically if you have set the Change Output Point 
option. If the output point is consistent with the flank of the groove to be machined, the output point is changed 
when the other flank of the groove is machined. At the end of the operation, the output point is the same as it 
was at the start of the operation. See Changing the Output Point for more information.

Approach and Retract Macros for Groove Finishing

The following Approach and Retract macros are proposed: re proposed: Direct, Axial-radial, Radial-axial, and 
Build by user.
The selected macro type (Approach or Retract) defines the tool motion before or after machining: Various 



feedrates are available for the approach and retract motions (RAPID, lead-in, lift-off, and so on).

See Define Macros on a Turning Operation for more information.
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Ramp Rough Turning Operations

The information in this section will help you create and edit Ramp Rough Turning operations in your manufacturing 
program. This type of operation is suitable for machining hard materials using round ceramic inserts, thereby minimizing 
wear and cutting stress.

The Ramp Rough Turning operation allows you to specify: 

●     Longitudinal and Face roughing modes

●     external, internal or frontal machining according to the type of area to machine

●     relimitation of the area to machine

●     various approach and retract path types

●     various lead-in and lift-off options with specific feedrates

●     rework machining.

The following topics are dealt with in the paragraphs below:

●     Tooling

●     Geometry including Part and Stock Offsets

●     Location and Limits

●     Machining Strategy Parameters

●     Feeds and Speeds

●     Tool Compensation

●     Macros.

Tooling for Ramp Rough Turning

The following tooling may be used: 

●     External and Internal insert-holders with round inserts. 

Note that the following attributes may influence machining (they are located on the Insert-holder's Technology tab):

●     Trailing angle

●     Leading angle

●     Max Recessing Depth

●     Max Boring Depth.

These attributes take tooling accessibility into account and may reduce the machined area.
However, you can use the Insert-Holder Constraints option on the operation editor to either ignore or apply these 
tooling attributes. You can replay the operation to verify the influence of these attributes on the generated tool path.

Note that the Insert-Holder Constraints setting does not influence the Entry Flank Angle defined in the operation editor.

Geometry for Ramp Rough Turning

Part and Stock profiles are required. They can be specified as follows:



●     select edges either directly or after selecting the By Curve contextual command. In this case the Edge Selection 
toolbar appears to help you specify the guiding contour.

●     select the Sectioning contextual command. Please refer to Sectioning for details of how to use this capability.
Please note that the sectioning selection method is not associative.

The End Limit option allows you to specify a point, line, curve or face to relimit or extrapolate the selected part profile. If 
a face is specified, the end element is the intersection of the face and the working plane. The position of the end of 
machining is defined with respect to this element by one of the following settings: None / In / On / Out.

Relimiting the area to machine by means of limit elements

If you specify a point, it is projected onto the part profile. 
A line through the projected point parallel to the radial axis delimits the area to machine.

If you specify a line, its intersection with the part profile is calculated (if necessary, the line is extrapolated). 
A line through the intersection point parallel to the radial axis delimits the area to machine.

If you specify a curve, its intersection with the part profile is calculated (if necessary, the curve is extrapolated using the 
tangent at the curve extremity). 
A line through the intersection point parallel to the radial axis delimits the area to machine.

Orientation for Ramp Rough Turning

The following Orientations are proposed: Internal, External and Frontal (for Face Roughing only).

The selected Orientation defines the type of geometric relimitation to be done between the stock and part geometry in 
order to determine the area to machine. Selected part and stock profiles do not need to be joined (see the following 
figures).

External Ramp Rough Turning

 

Internal Ramp Rough Turning
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Frontal Ramp Rough Turning 

Frontal machining is proposed for face Ramp Rough Turning. In that case, the minimum and maximum diameters of the 
area to machine are determined by the stock profile dimensions. 

For example, in the following figure the area to machine is relimited by the spindle axis because the stock profile is also 
relimited by the spindle axis. 

 

Part and Stock Offsets for Ramp Rough Turning

●     Stock offset: specifies a virtual displacement of the stock profile.

●     Part offset: specifies a virtual displacement of the part profile.



 

●     Axial part offset: specifies a virtual displacement of the part profile along the spindle axis direction.

 

●     Radial part offset: specifies a virtual displacement of the part profile in the radial axis direction.



 

●     End limit offset: distance with respect to the end element (only if end element is a line or a curve, and when In or 
Out  is set for end element positioning).

Offsets can be positive or negative with any absolute value. The global offset applied to the part profile is the resulting 
value of the normal, axial and radial offsets.

Location and Limits for Ramp Rough Turning

The following machining Locations are proposed:

●     Front, the part is machined toward the head stock

●     Back, the part is machined from the head stock.

 

Orientation and Location settings determine the way the program closes the area to machine.  The following options allow 
you to restrict the area to machine that is pre-defined by the stock and part. You may want to restrict this area due to the 
physical characteristics of the tool and the type of machining to be done.

Minimum Machining Radius 



 

Maximum Machining Radius (for internal machining) 

 

Note that Max Boring Depth is defined on the tool.

Axial Limit for Chuck Jaws (for external or frontal machining): Offset defined from the machining axis system. 

Machining Strategy Parameters for Ramp Rough Turning

Path Definition for Ramp Rough Turning

●     Machining tolerance

●     Max Depth of Cut



This option is used to specify the maximum distance between passes.

●     Under Spindle Axis Machining
For Face Ramp Rough Turning, this option allows you to request machining under the spindle axis.

●     Machining Direction (only for Face Roughing with Frontal machining) 
You can specify the machining direction with respect to the spindle axis by means of the To/From Spindle Axis choice.

●     Entry Flank Angle
The insert geometry is taken into account to avoid collision by reducing the maximum slope on which machining can be 
done. Defining a Entry Flank Angle on the operation allows you to further reduce the area to machine. 

Note that a leading angle can also be defined on the insert-holder to define the maximum slope on which machining 
can be done. In this case and if the Insert-Holder Constraints setting is applied (see above), the angle that reduces 
the slope the most will be taken into account.

●     Start pass mode is defined by one of the following settings:  Chamfer, Rounded, None.

●     If Rework mode is set, the following options are available:
❍     Distance before Rework Plunge

❍     Angle before Rework Plunge.

Lead-in and Lift-off for Ramp Rough Turning

These options allow penetration into the workpiece at a reduced feedrate in order to prevent tool damage. 

●     Lead-in Distance
Defined with respect to the cutting direction. It takes the stock profile and stock clearance into account. The tool is in 
RAPID mode before this distance.

●     Lift-off Distance and Lift-off Angle
These parameters define the lift-off vector at the end of each pass with respect to the cutting direction.

 

Feeds and Speeds for Ramp Rough Turning

Speed unit can be set to: 

●     Angular: spindle speed in revolutions per minute

●     Linear: constant cutting speed in units per minute

then you can give a Machining Speed value. 

Available feedrates in units per revolution are as follows:



●     Machining 

●     Lead-in 

●     Lift-off 

●     Plunge

●     Light loading 

●     Air cutting.

Feedrates in units per minute are also available for air cutting (for example, during macro motions and path transitions).
Note that RAPID feedrate can be replaced by Air Cutting feedrate in tool trajectories (except in macros) by selecting the 

checkbox in the Feed and Speeds tab page .

Dwell setting indicates whether the tool dwell at the end of each path is to be set in seconds or a number of spindle 
revolutions.

Please note that decimal values can be used for the number of revolutions. For example, when machining big parts that 
have a large volume, it can be useful to specify a dwell using a value of less than one revolution (0.25, for example).

Tool Compensation for Ramp Rough Turning  

You can select a tool compensation number corresponding to the desired tool output point. Note that the usable 
compensation numbers are defined on the tool assembly linked to the machining operation. If you do not select a tool 
compensation number, the output point corresponding to type P9 will be used by default.

Approach, Retract and Linking Macros for Ramp Rough Turning

The following Approach and Retract macro modes are proposed: Direct, Axial-radial, Radial-axial, and Build by user.
The selected macro type (Approach or Retract) defines the tool motion before or after machining. Various feedrates are 
available for the approach and retract motions (RAPID, lead-in, lift-off, and so on).

   

Linking macros, which comprise retract and approach motion can also be used on Ramp Rough Turning operations.
Approach and retract motions of Linking macros are interruptible. It can be useful to interrupt an operation when the 
foreseeable lifetime of the insert is not long enough to complete the machining.

See Define Macros on a Turning Operation for more information.
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Ramp Recess Turning Operations

The information in this section will help you create and edit Ramp Recess Turning operations in your 
manufacturing program. This type of operation is suitable for machining hard materials using round ceramic 
inserts, thereby minimizing wear and cutting stress.

The Ramp Recess Turning operation allows you to machine a recess by means of a One Way or Zig Zag tool 
motion.

You can specify:

●     external, internal, frontal or inclined machining according to the type of area to machine

●     various approach and retract path types

●     various plunge and lift-off options with specific feedrates

●     part contouring

●     rework

●     tool output point change.

The following topics are dealt with in the paragraphs below:

●     Tools

●     Geometry

●     Machining Strategy Parameters

●     Feeds and Speeds

●     Tool Compensation

●     Macros.

Tooling for Ramp Recess Turning

The following tooling may be used: 

●     External and Internal insert-holders with round inserts. 

Note that the following attributes may influence machining (they are located on the Insert-holder's 
Technology tab):

●     Trailing angle

●     Leading angle

●     Max Recessing Depth

●     Max Boring Depth.



These attributes take tooling accessibility into account and may reduce the machined area.
However, you can use the Insert-Holder Constraints option on the operation editor to either ignore or 
apply these tooling attributes. You can replay the operation to verify the influence of these attributes on the 
generated tool path.

Note that the Insert-Holder Constraints setting does not influence the Flank Gouging Angle or the Entry 
and Exit Flank Angles defined in the operation editor.

Geometry for Ramp Recess Turning

Part and Stock profiles are required. They can be specified as follows:

●     select edges either directly or after selecting the By Curve contextual command. In this case the Edge 
Selection toolbar appears to help you specify the guiding contour.

●     select the Sectioning contextual command. Please refer to Sectioning for details of how to use this 
capability.
Please note that the sectioning selection method is not associative.

Orientation for Ramp Recess Turning

The following Orientations are proposed: internal, external, frontal and inclined. 

The selected Orientation defines the type of geometric relimitation to be done between the stock and part 
geometry in order to determine the area to machine. For an inclined orientation you must specify the Angle 
of Incline. 

Part and Stock Offsets for Ramp Recess Turning

●     Stock offset, which is defined perpendicular to the stock profile

●     Part offset, which is defined perpendicular to the part profile.

●     Axial part offset.

●     Radial part offset.

Offsets can be positive or negative with any absolute value. The global offset applied to the part profile is 
the resulting value of the normal, axial and radial offsets. 

Unsupported Geometry for Ramp Recess Turning

In a case like the one shown in the figure below, if the depth of cut is not sufficient, it is not possible to 
reach the righthand flank. 
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A warning message is issued recommending you to machine the profile in two operations.
Other possibilities to work around the problem are:

●     add an offset to the profile

●     increase the depth of cut.

Machining Strategy Parameters for Ramp Recess Turning

Path Definition for Ramp Recess Turning

●     Ramp Recess Turning Mode: One Way or Zig Zag

●     Max Depth of Cut
This option is used to specify the maximum distance between passes.

●     Machining Tolerance

●     Machining Direction 
For Zig Zag tool motion, you must specify a first cutting direction as follows: 

❍     To or From Head Stock for Internal and External machining

❍     To or From Spindle for Frontal machining

❍     To Right or Left of Recess for Inclined machining.

When a part profile has multiple recesses (that is, a non-convex profile along the cutting direction), only 
the first recess along the specified direction is machined. 

●     Entry and Exit Flank Angles (for One way mode only).
The insert geometry is taken into account to avoid collision by reducing the maximum slope on which 
machining can be done. Defining Entry and Exit Flank Angles on the operation allow you to further 
reduce the area to machine. 

Note that leading and trailing angles can also be defined on the insert-holder to define the maximum 
slope on which machining can be done. In this case and if the Insert-Holder Constraints setting is 
applied (see above),the angles that reduce the slope the most will be taken into account.

●     Flank Gouging Angle (for Zig Zag mode only)
Angles of the insert are taken into account to avoid collision by reducing the maximum slope on which 
machining can be done. Defining a Flank Gouging Angle on the operation allows you to further reduce 
the area to machine. 

Note that a gouging angle can also be defined on the insert-holder to define the maximum slope on 
which machining can be done. In this case and if the Insert-Holder Constraints setting is applied (see 
above),the angle that reduces the slope the most will be taken into account.

●     Under Spindle Axis Machining



For Frontal or Inclined machining, this option allows you to request machining under the spindle axis.

●     Part Contouring
You can specify if contouring is required by means of the proposed checkbox.
The part profile is followed at the end of recessing. This is done by machining down the sides of the 
recess in order to clear the profile.

 

Plunge and Lift-off for Ramp Recess Turning

●     Angle and Distance before Plunge
Define the plunge vector before each new pass with respect to the cutting direction.

●     Lift-off Distance and Lift-off Angle
Define the lift-off vector at the end of the last pass with respect to the cutting direction. The figure 
below shows the effect of a positive lift-off angle (external machining is assumed).



●     If Rework mode is set, the following options are available:
❍     Distance before Rework Plunge

❍     Angle before Rework Plunge.

Feeds and Speeds for Ramp Recess Turning

Speed unit can be set to: 

●     Angular: spindle speed in revolutions per minute

●     Linear: constant cutting speed in units per minute

then you can give a Machining Speed value. 

Available feedrates in units per revolution are as follows:

●     Machining 

●     Lift-off 

●     Contouring 

●     Plunge 

●     Light loading 

●     Air cutting.

Dwell setting indicates whether the tool dwell at the end of each path is to be set in seconds or a number of 
spindle revolutions.

Feedrates in units per minute are also available for air cutting such as macro motions and path transitions. 
Note that RAPID feedrate can be replaced by Air Cutting feedrate in tool trajectories (except in macros) by 

selecting the checkbox in the Feed and Speeds tab page .

Please note that decimal values can be used for the number of revolutions. For example, when machining 



big parts that have a large volume, it can be useful to specify a dwell using a value of less than one 
revolution (0.25, for example).

Tool Compensation for Ramp Recess Turning

You can select a tool compensation number corresponding to the desired tool output point. Note that the 
usable compensation numbers are defined on the tool assembly linked to the machining operation. If you 
do not select a tool compensation number, the output point corresponding to type P9 will be used by 
default.

Note that the change of output point is managed automatically if you set the Change Output Point option. 

If the output point is consistent with the flank of the recess to be machined, the output point is changed 
when the other flank of the recess is machined.
At the end of the operation, the output point is the same as it was at the start of the operation. See 
Changing the Output Point for more information.

Approach, Retract and Linking Macros for Ramp Recess Turning

The following Approach and Retract macros are proposed: Direct, Axial-radial, Radial-axial, and Build by 
user.
The selected macro type (Approach or Retract) defines the tool motion before or after machining. Various 
feedrates are available for the approach and retract motions (RAPID, lead-in, lift-off, and so on).

Linking macros, which comprise retract and approach motion can also be used on Ramp Recess Turning 
operations.
Approach and retract motions of Linking macros are interruptible. It can be useful to interrupt an operation 
when the foreseeable lifetime of the insert is not long enough to complete the machining.

See Define Macros on a Turning Operation for more information.
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Thread Turning Operations
The information in this section will help you create and edit Thread Turning operations in your 
manufacturing program. 

The Thread Turning operation allows you to specify: 

●     the type of machining according to the required thread (external or internal)

●     relimitation of the profile by start and end elements

●     thread machining options

●     various approach and retract types

●     PP Word syntaxes.

The following topics are dealt with in the paragraphs below:

●     Tooling

●     Geometry

●     Machining Strategy Parameters

●     CYCLE or GOTO Output Syntaxes

●     Editing CYCLE Syntaxes

●     Tool Compensation

●     Macros.

Tooling for Thread Turning

The following tooling may be used: 

●     Internal and External threading insert-holders with thread inserts. 

Geometry for Thread Turning

A Part profile is required. It can be specified as follows:

●     select edges either directly or after selecting the By Curve contextual command. In this case the Edge 
Selection toolbar appears to help you specify the guiding contour.

●     select the Sectioning contextual command. Please refer to Sectioning for details of how to use this 
capability.
Please note that the sectioning selection method is not associative.

End Limit: None / In / On / Out
This option allows you to specify a point, line, curve or face as the end element of the profile to be 
machined. If a face is specified, the end element is the intersection of the face and the working plane. The 
position of the end of machining is also defined with respect to this element.
In / On / Out allows you to specify the Go-Go type positioning of the tool with respect to the end element. 
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The On option is always used for a point type end element. 
If needed, the profile may be extrapolated to the end element.

End Limit Offset: distance with respect to the end element (only if end element is a line, curve or face, 
and when In or Out is set for end element positioning).

Start Limit: None / In / On / Out
This option allows you to specify a point, line, curve or face as the start element of the profile to be 
machined. If a face is specified, the start element is the intersection of the face and the working plane. 
The position of the start of machining is also defined with respect to this element. 
In / On / Out allows you to specify the Go-Go type positioning of the tool with respect to the start element. 
The On option is always used for a point type end element. 
If needed, the profile may be extrapolated to the start element.

Start Limit offset: distance with respect to the start element (only if start element is a line, curve or 
face, and when In or Out  is set for start element positioning).

Relimiting the area to machine by means of limit elements

If you specify a point, it is projected onto the part profile. 
A line through the projected point parallel to the radial axis delimits the area to machine.

If you specify a line, its intersection with the part profile is calculated (if necessary, the line is 
extrapolated). 
A line through the intersection point parallel to the radial axis delimits the area to machine.

If you specify a curve, its intersection with the part profile is calculated (if necessary, the curve is 
extrapolated using the tangent at the curve extremity). 
A line through the intersection point parallel to the radial axis delimits the area to machine.

Orientation and Location for Thread Turning

●     Orientation: Internal / External
This option allows you to specify the type of machining according to the location of the area to machine 
on the part.

●     Location: Front / Back 
❍     Front, the profile is machined toward the head stock

❍     Back, the profile is machined from the head stock.

Threads

●     Thread profile: ISO / Trapezoidal / UNC / Gas / Other
Other allows defining a specific thread profile.

●     Thread unit: Pitch / Threads per Inch 
You must specify the thread type when the Thread profile is Other. Thread is automatically set to Pitch 
for the ISO and Trapezoidal types and set to Threads per Inch for UNC and Gas.

●     Nominal diameter 
This value must be given when Thread type is internal and Thread profile is Other.

●     Thread length
This value must be given when the Start or End relimiting element is set to Profile End.

●     Thread pitch 
This value must be given when the Thread type is set to Pitch or the Thread profile is ISO or 



Trapezoidal.

●     Threads/inch
This value must be given when the Thread type is set to Thread per inch or when the Thread profile is 
UNC or Gas.

●     Thread depth
This value must be given when the Thread profile is Other.

●     Number of threads
When greater than 1, this value allows you to specify whether a multi-start thread is to be machined.

Machining Strategy Parameters for Thread Turning

Machining Options for Thread Turning

●     Threading type. You must choose the desired threading type: 
❍     Constant depth of cut

❍     Constant section of cut

●     Maximum Depth of cut when Threading type is set to Constant depth of cut

●     Number of passes when Threading type is set to Constant section of cut.
When the number of passes is defined, the Section of cut value is automatically set.

●     Machining spindle speed  in revolutions per minute

●     Thread Penetration type: 
❍     Straight

❍     Oblique (penetration angle must be specified)

❍     Alternate (penetration angle must be specified).

Path Computation options for Thread Turning

●     Clearance on crest diameter

●     Lead-in Distance
Defined with respect to the cutting direction. The tool is in RAPID mode before this distance.

●     Lift-off Distance and Lift-off Angle.
These parameters define the lift-off vector at the end of each pass with respect to the cutting direction. 
The figure below shows the effect of a positive lift-off angle (external machining is assumed).



 

First and Last Passes options for Thread Turning

●     Manage penetration on first passes by means of the First passes check box. This option is available 
when Threading type is set to Constant section of cut. When activated, you must specify values for: 

❍     Number of first passes

❍     First section rate.

When these two values are specified, the Section of cut for first passes value is automatically 
set. 

●     Manage penetration on the last passes by means of the Last passes check box. When activated, you 
must specify: 

❍     Number of last passes

❍     Depth of cut for last passes.

●     Manage the spring passes by means of the Spring passes check box. When activated, you must 
specify a Number of spring passes.

CYCLE or GOTO Output Syntaxes

If you want to generate CYCLE statements, you must select the Output CYCLE syntax checkbox in the 
Options tab and set the Syntax Used option to Yes in the NC Output generation dialog box.
Otherwise, GOTO statements will be generated. 

The parameters available for PP word syntaxes for this type of operation are described in the 
NC_LATHE_THREADING section of the Manufacturing Infrastructure User's Guide.

Editing CYCLE Syntaxes 

The Edit Cycle command in the Thread Turning dialog box allows you to:

●     display the unresolved syntax of the NC Instruction of the operation. This is the syntax as specified in 
the PP table referenced by the current Part Operation.
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●     display and, if needed, edit the syntax that is resolved either by geometric selection and user entries.

The Cycle Syntax Edition dialog box is displayed when you click the Edit Cycle command.

You can access all the CYCLE syntaxes contained in the current PP table by means of the PP instruction 

 icon. You can then select the desired syntax to be used by means of the procedure described in the 

Insert PP Instruction section.

Tool Compensation for Thread Turning 

You can select a tool compensation number corresponding to the desired tool output point. Note that 
the usable compensation numbers are defined on the tool assembly linked to the machining operation. If 
you do not select a tool compensation number, the output point corresponding to type P9 will be used by 
default. 
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Note that the change of output point is managed automatically if you set the Change Output Point 
option for Trapezoidal or Other Thread profile.

Approach and Retract Macros for Thread Turning 

The following Approach and Retract macros are proposed: Direct, Axial-radial, Radial-axial, and Build by 
user.
The selected macro type (Approach or Retract) defines the tool motion before or after machining. Various 
feedrates are available for the approach and retract motions (RAPID, air-cutting, and so on).

See Define Macros on a Turning Operation for more information.
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Sequential Turning Operations
The information in this section will help you create and edit Sequential Turning operations in your 
manufacturing program. 

You can create a sequence of basic Go, Go InDirv, Go Delta, and Follow tool motions in a single Sequential 
Turning operation. PP words can be inserted in the sequence of tool motions.

When you select the Tool motion management icon a panel is displayed listing any previously created tool 
motions and PP words. You can create or edit tool motions and PP words.

If there are no previously created tool motions listed in the Sequential Turning dialog box, the first one 
must be a Go Standard motion to a point. It specifies either the absolute start position from where the 
following position can be computed or the end point of the approach macro (if the operation has one).

When defining a tool motion, the corresponding new tool position is displayed according to all the options 
that were selected for creating this motion.

The following topics are dealt with in the paragraphs below:

●     Tooling

●     Geometry

●     Go Motion

●     Go InDirv Motion

●     Go Delta Motion

●     Follow Motion

●     Feeds and Speeds.

Tooling for Sequential Turning

All tool types with compatible inserts are authorized. 

Geometry Selection for Sequential Turning

You can select lines, curves and edge elements as check and drive elements. Points can also be selected 
as checks. Selected elements must be located in the plane defined by the machine spindle axis and radial 
axis. 

The following table summarizes how the tool is positioned with respect to a check element depending on 
the TO/PAST modes and negative/positive offset values.

Positive offset Negative offset



To

Past

Go Motion

In Go motion, the program positions the tool with respect to one or two check elements. 

When only one check element is selected, the tool is projected onto the check element.

When two check elements are selected, the tool is positioned with respect to the two check elements.

The tool is positioned with respect to each check element depending on the TO-ON-PAST mode. 

TO: the tool nose is positioned tangent to the near side of the selected element with a possible offset.
ON: the tool nose is positioned on the selected element, with a possible axial or radial offset (normal 
offset, collision avoidance and safety angles are not applicable).
PAST: the tool nose is positioned tangent to the far side of the selected element with a possible offset.

The first check element can be point, line, curve, or edge type elements.
If it is a point, no second check element can be selected. Otherwise, the second check element can be line, 
curve or edge type elements. 

The following options are available when defining a Go motion:

●     Control over geometric extrapolation of each check curve.

●     Axial, radial and normal offsets with respect to each check element.



●     Feedrate and spindle speed.

●     Collision avoidance for each check element when the tool is positioned in TO or PAST mode.

●     Left and right safety angles when collision avoidance is used.

●     Machining tolerance

●     Tool compensation

●     Guiding Point, if a square or grooving insert is used.

Note that the positioning mode (TO, ON, PAST) and offsets are not applicable when the tool is positioned 
on a point. 

Go InDirv Motion

In Go InDirv (Go in Direction Vector) motion, the tool moves in a given direction up to the selected check 
curve.
The tool is positioned with respect to the selected element depending on the TO-ON-PAST mode. 

TO: the tool nose is positioned tangent to the near side of the selected element with a possible offset.
ON: the tool nose is positioned on the selected element, with a possible axial or radial offset (normal 
offset, collision avoidance and safety angles are not applicable).
PAST: the tool nose is positioned tangent to the far side of the selected element with a possible offset.

The selected check curve can be edge, line and curve type elements.

The following options are available when defining a Go InDirv motion:

●     Drive element type: line or angle.

●     Angle of drive, if drive element type is angle.

●     Drive direction: Same or Inverted.
This is useful in the particular case when two positions are reachable.

●     Control over geometric extrapolation of check curve.

●     Axial, radial and normal offsets with respect to the check element.

●     Feedrate and spindle speed.

●     Collision avoidance when the tool is positioned in TO or PAST mode.

●     Left and right safety angles when collision avoidance is used.

●     Machining tolerance

●     Tool compensation

●     Guiding Point, if a square or grooving insert is used.

Go Delta Motion 

In Go Delta motion, the tool move is based on the current position of the tool. The TO-ON-PAST mode is 
not proposed. 

The following options are available when defining a Go Delta motion:

●     Delta check mode: 



❍     Distance between two points (two points are to be selected)

❍     Line and distance (line and distance are to be selected)

❍     Angle and distance (angle and distance are to be given)

❍     Axial and radial (axial and radial offsets are to be given)

●     Feedrate and spindle speed.

●     Machining tolerance

●     Tool compensation.

Follow Motion 

In Follow motion, the tool follows a drive element up to a check element. The check element is to be 
selected in the Follow motion and can be an edge, line, a curve or a point. 

The drive element is a curve on which the tool is positioned by a preceding motion. Therefore, the 
preceding motion must be a Go, Go InDirv or Follow motion. A Go to a point or a Go Delta cannot precede 
a Follow motion.

If the preceding motion is a Go motion, the first selected check curve is used as drive curve for the Follow 
motion.

If the preceding motion is a Go InDirv motion, the selected check curve is used as drive curve for the 
Follow motion.

If the preceding motion is a Follow motion, the check element of the preceding Follow motion is used as 
drive curve when this check element is not a point and the Change Drive option of the preceding Follow 
motion is set. Otherwise, both consecutive Follow motions share the same drive curve.

Note that:

●     the offsets applied to follow the drive element are also defined on the same preceding motion. When 
the drive and check curves are tangent, any offset values on the check curve should be the same on 
the tangent drive curve.

●     the collision avoidance and the control over geometry extrapolation on drive curve are also defined on 
the same preceding motion.

The tool will follow the drive element up to the check element. The final tool position will be determined by 
the TO-ON-PAST mode:
TO: tool nose tangent to the drive element and before the check element with a possible offset.
ON: tool nose tangent to the drive element and on the check element, with a possible axial or radial offset 
(normal offset is not applicable).
PAST: tool nose tangent to the drive element and after the check element with a possible offset.

The following options are available when defining a Follow motion:

●     Drive direction: Same or Inverted.
This is useful in the particular case when two positions are reachable.

●     Control over geometric extrapolation of check curve.

●     Axial, radial and normal offsets with respect to the check element.



●     Feedrate and spindle speed.

●     Collision avoidance when the tool is positioned in TO or PAST mode.

●     Left and right safety angles when collision avoidance is used.

●     Machining tolerance

●     Tool compensation

●     Guiding Point, if a square or grooving insert is used.

Control over Geometric Extrapolation of Check Curve

When check limit mode is set to Extended, a virtual tangent element is added to each extremity of the 
check element before it is actually taken into account as a check element. 
Therefore, if there is no intersection between the drive and check elements, the final tool position may be 
located at the intersection of the drive curve and a tangent of the check element. 

When check limit mode is set to Actual, no virtual tangent element is added. 
Therefore, the final tool position is located on the check element. 

Furthermore, please note that control over geometric extrapolation is not controlled in the Follow motion 
but on the preceding motion that positions the tool on the drive element.

Note that collision avoidance is taken into account for positioning in ON mode, and that left and right 
safety angles are only considered in collision avoidance mode.

Feeds and Speeds for Sequential Turning

Speed unit can be set to: 

●     Angular: spindle speed in revolutions per minute

●     Linear: constant cutting speed in units per minute

then you can give a Machining Speed value. 

Available feedrates in units per revolution are as follows:

●     Machining Feedrate  

●     Lift-off Feedrate  

●     Lead-in Feedrate.

In addition to these global feedrates, local feedrates can be applied to each tool motion.



Tool Assembly Conventions for Turning

General Comments

The Machining Axis is always a direct axis system. For example, ZX defines a direct axis system with Z as the spindle axis and 
X as the radial axis.

Selected geometry (for example, Finish Profile Turning) can be selected either in X+ or X- :

●     the system will figure out whether machining is in X+ or X- based on Insert-Holder orientation (as defined using Set-Up 
Angle)

●     depending on the options of a Machining Operation, several possibilities might exist,
(for example, Frontal machining). User option is then available (X+/X-) to specify what the system should do.

The Output Point definition is considered according to the X+/Z+ quadrant.

Examples below deal with Horizontal Lathe Machine Tool.

 

Insert Holder

Different settings of the Setup Angle, Invert Tool and Hand Style parameters result in different configurations for positioning 
the tool .

Left Tool: Insert is visible and points to left: Inverted Left Tool :

 

 

Right Tool: Insert is visible and points to right: Inverted Right Tool:

 

 



 

Output Point

In the following figure reference is made according to the Spindle/Radial Axis (Z/X) 

 

Spindle Rotary Direction

With a Horizontal Lathe Machine Tool the convention for spindle rotary direction defined in the Machine Editor dialog box is as 
follows:
Looking into Z direction, Chuck & Jaws at your back.

Clockwise Counterclockwise



The following represent common settings: 

 

180deg Setup Angle

When Setup angle is set to 180deg, machining takes places in X- as system detects that this is what the tool can machine 
(geometry can be selected in X+ or X-).

 

Direct Machining Axis

As the Machining Axis is always considered as being direct, the two situations below are the same (this corresponds to a 
rotation around the spindle axis).



 

Summary

The following figures summarize conditions for lathe tool assemblies. 

The figure below shows other settings for different output points. 





Methodology
This section provides methodology and conceptual information on the following Lathe Machining topics. 

Cutter Compensation and Finish Operations
How to Change the Output Point

How to Update Input Stock
Turning on a Milling Center with Facing Head

Methodology and conceptual information on the following topics is provided in the NC Manufacturing 
Infrastructure User's Guide.

Machining Processes
Knowledgeware in Machining Processes

CATProduct and CATProcess Document Management
Design Changes and Associativity Mechanisms

Part Operation and Set Up Documents
User Features for NC Manufacturing
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Cutter Compensation with Finish Operations
The Cutter Compensation: None / On / Reverse option is proposed for finish operations. If this option is set 
to On or Reverse, the NC output will include CUTCOM instructions in the APT or clfile output for cutter 
compensation (CUTCOM/RIGHT, CUTCOM/LEFT, CUTCOM/OFF). 

●     On: CUTCOM/RIGHT instruction generated if tool is to the right of the toolpath and CUTCOM/LEFT if tool is to 
the left of the toolpath

●     Reverse: CUTCOM/RIGHT instruction generated if tool is to the left of the toolpath and CUTCOM/LEFT if tool 
is to the right of the toolpath.

Otherwise, if the option is set to None, no CUTCOM instruction will be included in the NC data output.  

A CUTCOM instruction is always generated before a linear trajectory in order to be active on that displacement:

●     for a tool approach, the instruction CUTCOM/RIGHT or CUTCOM/LEFT is generated at latest in the approach 
phase of the trajectory, before the lead-in and on a linear trajectory

●     for a tool retract, the instruction CUTCOM/OFF is generated at earliest in the retract phase of the trajectory, 
before a linear trajectory or the last point of the operation.

The figure below illustrates a Profile Finishing operation that has circular lead-in and linear lift-off.  

 

If the cutter compensation is set to ON, the CUTCOM instructions are generated as follows:

●     CUTCOM/RIGHT is generated at point 1, before the tool motion to point 2.
Note that if lead-in was linear, CUTCOM/RIGHT would be generated at point 2, before the tool motion to 
point 3.

●     CUTCOM/OFF is generated at point 4, before the tool motion to point 5.
Note that if lift-off was circular CUTCOM/OFF would be generated at point 5, before the linear retract motion.



How to Use Cutter Compensation

The computed toolpath corresponds to the trajectory followed by the output point of the tool used in the Part 
Operation. 

You should set Cutter Compensation to On in the following cases:

●     the cutter radius of the actual tool used for machining is greater than the radius of the programmed tool and 
a positive compensation value is entered at the NC machine

●     the cutter radius of the actual tool used for machining is less than the radius of the programmed tool and a 
negative compensation value is entered at the NC machine.

You should set Cutter Compensation to Reverse in the following cases: 

●     the cutter radius of the actual tool used for machining is less than the radius of the programmed tool and a 
positive compensation value is entered at the NC machine

●     the cutter radius of the actual tool used for machining is greater than the radius of the programmed tool and 
a negative compensation value is entered at the NC machine.

Some Recommendations 

In general you should program with tools whose cutter radius is greater than those that will actually be used on 
the machine. This will help you anticipate tool/part collisions that may arise when cutter compensation is used. 

If negative compensation values are allowed on the machine, set Cutter Compensation to On. 

If negative compensation values are not allowed on the machine set Cutter Compensation to:

●     On, if the tool actually used has a greater cutter radius than the programmed tool

●     Reverse, if the tool actually used has a smaller cutter radius than the programmed tool.

The figure below illustrates cutter compensation for profile finishing. 



 



Changing the Output Point
An option for changing the tool output point is available for: 

●     Recessing, Ramping Recessing, Grooving, and Groove Finishing operations using grooving tools or inserts

●     certain Threading operations using threading tools or inserts.

When Change Output Point is set the tool output point is changed automatically during the operation 
according to the profile geometry to be machined. 

For Grooving and Groove Finishing operations, tool output point changes are made out of the profile. 

For Recessing operations, tool output point changes are made before each tool motion involving machining (that 
is, after each plunge). However, changes are only done:

●     if machining is consistent with the selected tool output point

●     if another output point is defined on the tool so that the tool output point change can be made.

Otherwise, the tool output point will not be changed. 

Example of Groove Finishing

The following figure illustrates tool output point changes in a Groove Finishing operation that uses a grooving 
tool. In this example, at the start of operation the tool output point is P9. 



 

If the first flank to machine is flank 1, the tool motion is as follows:

●     approach and lead-in motion to flank 1

●     machine down flank 1

●     lift-off from part profile

●     tool output point change: tool output point is P9R

●     approach and lead-in motion to flank 2

●     machine down flank 2

●     lift-off to Exit Point

●     tool output point change: tool output point is P9 (as at start of operation).

If the first flank to machine was flank 2, the tool motion would be as follows: 

●     tool output point change: tool output point is P9R



●     approach and lead-in motion to flank 2

●     machine down flank 2

●     lift-off from part profile

●     tool output point change: tool output point is P9 and the guiding point is LEFT

●     approach and lead-in motion to flank 1

●     machine down flank 1

●     lift-off to Exit Point.

If P9 is the tool output point and if the output point P9R is defined on the tool, the output point change is only 
done for grooving tools. 

The tool output point at the end of operation is the same as at the start of operation. 

Example of Recessing

The figure below illustrates a Recessing operation when a round insert is used. The tool output point changes 
during an operation only if the output point at the start of operation is P2, P3 or P9 for a frontal recess or P3, P4 
or P9 for an external recess.

 

The tool output point is dependent on the machine axis system. 



How to Update Input Stock

When you create a new turning operation, you can generate geometry from the previous operations in your program then use that 
geometry as stock for the new operation.

This is done using the Update Input Stock command in the machining operation editor. The Stock computation is done before you 
select geometry (stock or part) in your new operation. It creates a sketch that highlights the remaining material on the part. The 
computation takes into account all complete operations in the program before the one being edited.

Stock computation is based on the stock solid specified in the Part Operation dialog box. The primitives of the material removed by 
each previous operation are subtracted from this stock. The removed area computation takes the parameters of the machining 
operations into account. Stored or locked tool paths are not taken into account.

The result of the computation is a sketch which contains the view of the remaining material in the working plane. 

The operations taken into account for Stock computation are: 

●     Rough Turning

●     Groove Turning

●     Recess Turning

●     Profile Finish Turning

●     Groove Finish Turning

●     Sequential Turning

●     Ramp Rough Turning and Ramp Recess Turning

●     All Drilling operations along the spindle axis.

Thread Turning operations are not taken into account.

Defining the Machine and Stock

Firstly, you need to define a stock and a lathe machine on the Part Operation. 

Double click the Part Operation in the tree to display the Part Operation dialog box. 

Click the Machine icon in the dialog box the select a horizontal lathe machine. You must set up the spindle and radial axes correctly 
(that is, spindle to Z and radial axis to X in this example).
Click the Stock icon then select a solid representing the stock. Double click on the background to leave the geometry selection mode.

The dialog box is updated with the name of the selected machine and stock. 



Note:  

The generation of the stock is based on In Process Models (IPM).

For each stock part specified in the Part Operation dialog box, an IPM will be generated. The name of the IPM part will be the 
same as the reference stock part name with the prefix "IPM_". The IPM part will be created in the same location as the 
corresponding design part (the design part is considered instead of the stock part because often the stock part is just a body 
inside the design part).

For file system users, this means that the CATProduct that contains the design part will be modified with the addition of the 
IPM CATPart (under the root node of the CATProduct).  
The  CATProcess must be linked to a CATProduct that include the design part. The input stock calculation cannot be done if 
the CATProcess is not linked to the CATProduct.
The IPM CATPart is dedicated to the input stock calculation. No other geometry must be created in this CATPart. 

For PPR hub users, the IPM CATPart is inserted under the "Subassembly" node of the corresponding design part. 

Computing Stock

The following figure illustrates Stock computation after a Drilling (along the spindle axis) and a Roughing operation. Here is the tool 
path of the Roughing operation: 



When creating a new Roughing operation after Roughing.1, click the Update Input Stock icon  in the dialog box of the new 

Roughing operation. 

The following figure shows the result of the computation. The Stock has been created in orange. It is located in a sketch whose 
identifier is the name of the last operation taken into account for the computation (Roughing.1) plus the item StockSketch and the 
time of the computation. 

The Stock sketch has been created in a body with the same name, in a part named IPM_xxx (where xxx is the name of the selected 
stock solid). The part is located in a product with the same name.



You can now select elements of the Stock sketch as new Part or Stock of the Roughing.2 operation.

Stock Sketches, IPM Bodies and Primitives  

The Stock computation automatically creates an IPM body (CATPart). 

In order to create the Stock, some primitives are created in the IPM body. Once the stock sketch is created, the sketch is no longer 
linked to them.

The sketch of the input stock is linked to the operation. When editing the operation the sketch is in Show mode. When the operation 
editor is closed, the sketch is in Hide mode.

By right-clicking the Input stock status field in the Geometry tab page of the operation editor, it is possible to remove the stock 
sketch. In this case the sketch is deleted. 

A primitive is created for each Turning operation. Each primitive takes the machining paths of the tool trajectory into account. Note 
that macro, lead-in and lift-off motions are not taken into account in the computation of the operation's primitive as these are not 
machining paths.

If you use the Stock computation again, the existing primitives will speed up the computation. They will be used if the operations to 
which they are linked have not been modified since the Stock computation. Otherwise they will be modified.

If you have finished your Part Operation, you can remove these primitives by using the Clean Computed Stock Data contextual 
command on the Part Operation. This command removes each primitive of the IPM body linked to the operations in the Part 
Operation.  It does not remove the Stock sketches or the IPM body.

For a CATProcess created in a previous version, the previous IPM body will be migrated automatically. An IPM CATPart will be created 
for each solid selected as stock. 



Considerations for Machining Local Recesses

The Update Input Stock functionality is best suited to operations in which the stock is to be updated globally.

For a local recesses or grooves like the one shown below, you may be advised to to update the input stock manually. 

For example, the expected area to machine (in green) above may be interpreted by the program as the area to be machined (in green) 
below.



This is due to the ambiguity that arises due to the shape the selected stock profile.



 Turning on a Milling Center with Facing Head
This section provides information about creating turning operations on a 3-axis milling machine that is equipped with a 
rotary table and facing head. The main objective is to machine large diameter holes using turning techniques, which will 
give better quality results than milling.

In particular, this section explains how to:

●     set up your part and machining environment

●     define local machining axis systems and turning planes

●     create your program using either Machining Axis Changes or Table Rotations

●     replay and simulation

●     generate NC data from your program.

Set Up the Part and Machining Environment

The Part Operation editor allows you to set up the part and the machining environment.

Define the Reference Machining Axis System



Click the Reference Machining Axis System icon . The Machining Axis System dialog box appears for assigning a 

reference machining axis system to the part operation. This is similar to the procedure described in Insert Machining Axis 
Change.

The coordinates of the NC output data will be expressed in this axis system. However, when a local machining axis 
system is inserted in the program, coordinates will be expressed in the local axis system.

The reference machining axis system should be positioned such that it is Y-axis is collinear with the rotary axis of the 
machine (B).

Assign the Part to be Machined

Click the Product icon  to associate the part to machine (CATProduct or CATPart) to the part operation. 

Other important parameters to set in the Part Operation Editor are: 

●     Tool change point

●     Home Point: From Machine.

Select the Machine and Set Parameters

Click the Machine icon the select the 3-axis with Rotary Table Machine type in the Machine Editor. 

In the case of an actual machine with facing head on the shop floor, the XYZIJK output could be post-processed to pilot 
the U-axis of the facing head.
The tool mounted on the facing head machines along the profile of the hole.
Note that this information is not specified in the Machine Editor dialog box.

In the Numerical Control tab, select the following sample PP word table is delivered with the product in
\Startup\Manufacturing\PPTables\TURNING_ON_MILLING_CENTER.pptable

Other important parameters to set in the Machine Editor are: 

●     Reference orientation of rotary table: set to 0, 0, 1 for example

●     Rotary axis: set to B for example
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●     Home point, which is the start position when replaying a rotation if any motion is defined in the program.

Define Local Machining Axis Systems and Turning Planes

If you specify turning operations on a milling machine, they will be described in the ZX turning plane of the reference 
machining axis system.

To specify turning operations on a milling machine equipped with a facing head and rotary table, you must define local 
machining axis systems. Local turning planes will be derived from these Z and X axes of these axis systems. The 
geometry to machine must lie in the turning plane in order to create the turning operations.
The figure below shows a local machining axis system with the ZX turning plane and the selected geometry (Part Element 
in red) that lies in this plane.

Therefore at each change of turning plane, you must define a local machining axis for turning operations. This is needed 
for processing geometry and visualizing the tool assembly.

Methodology: Machining Axis Changes or Table Rotations

Using Machining Axis Changes

To output NC data in the axis system defining the local plane, you must define a Machining Axis System Change before 
each turning plane.

A typical program is shown in the figure below:



When NC data is generated in XYZIJK format, the IJK components will be the Z-axis of the local plane (see NC Data 
Output for more information).

Using Table Rotations

Define your turning operations in the corresponding local axis systems, then generate Machine Rotation instructions in the 
program using the command Generate Machine Rotation command.

A typical program is shown in the figure below:

When NC data is generated in XYZIJK format, the IJK components will be the Z-axis of the local plane (see NC Data 
Output for more information).

Replay and Simulation

You should replay the tool path to check each operation.

You should simulate the material removed by the program. You will need to specify design part and stock in the Part 
Operation editor.

NC Data Output

NC data output can be generated in XYZ or XYZIJK format. 
For XYZ data, you must generate table rotations in your program.
For XYZIJK data, the value that is output for IJK is taken on the Z axis (spindle) of the local machining axis system.

The following NC data statements will be generated at the start of each turning operation:

●     The coordinates of the origin of the local machining axis

●     An order to switch from the X-axis to the U-axis.
This is done through parameterized syntaxes in the PP table (NC_SPINDLE_LATHE or 
NC_LATHE_MO_START_COMMENT)



Using NC_SPINDLE_LATHE:

*START_NC_COMMAND NC_SPINDLE_LATHE
*START_LIST MFG_SPNDL_UNIT 
RPM ,SFM
*END
LOCAL_ORIGIN,%MFG_NCAXIS_X_ORIG,%MFG_NCAXIS_Y_ORIG,%MFG_NCAXIS_Z_ORIG
$$ SWITCH_FROM_X_TO_U
SPINDL/%MFG_SPNDL_SPEED,&MFG_SPNDL_UNIT
*END
*END

Using NC_LATHE_MO_START_COMMENT:

*START_NC_INSTRUCTION NC_LATHE_MO_START_COMMENT
*START_SEQUENCE
LOCAL_ORIGIN,%MFG_NCAXIS_X_ORIG,%MFG_NCAXIS_Y_ORIG,%MFG_NCAXIS_Z_ORIG
$$ SWITCH_FROM_X_TO_U
*END
*END

A typical APT output would be:

$$ OPERATION NAME : Profile Finish Turning.1
$$ Start generation of : Profile Finish Turning.1
SWITCH/9
FEDRAT/ 0.3000,MMPR
LOCAL_ORIGIN, 0.00000, 130.00000, 0.000000
$$ SWITCH_FROM_X_TO_U
SPINDL/ 70.0000,RPM
GOTO / ...

Some Points to Note 

The Update Input Stock capability is not available for turning operations on milling centers. The corresponding 
commands are not available in the Part Operation or Turning Operation editors.



Glossary 

             

A

approach 
macro

Motion defined for approaching the operation start point

auxiliary 
command

A control function such as tool change or machine table rotation. These commands may be 
interpreted by a specific post-processor.

axial 
machining 
operation

Operation in which machining is done along a single axis and is mainly intended for hole 
making (drilling, counter boring, and so on). 

D

DPM Digital Process for Manufacturing.

E

extension 
type

Defines the end type of a hole as being through hole or blind.

F 

feedrate Rate at which a cutter advances into a work piece. 
Measured in linear or angular units (mm/min or mm/rev, for example).

fixture Elements used to secure or support the workpiece on a machine.

G

gouge Area where the tool has removed too much material from the workpiece.

M

machine 
rotation

An auxiliary command in the program that corresponds to a rotation of the machine table.

machining 
axis system

Reference axis system in which coordinates of points of the tool path are given.

machining 
operation

Contains all the necessary information for machining a part of the workpiece using a single 
tool.



machining 
tolerance

The maximum allowed difference between the theoretical and computed tool path.

manufacturing 
process 

Defines the sequence of part operations necessary for the complete manufacture of a part.

manufacturing 
program

Describes the processing order of the NC entities that are taken into account for tool path 
computation: machining operations, auxiliary commands and PP instructions.

O

offset Specifies a virtual displacement of a reference geometric element in an operation (such as 
the offset on the bottom plane of a pocket, for example).
An offset value can be greater than, less than, or equal to zero. It is measured normal 
to the referenced geometry or in a specific direction such as axial or radial. 
For example, a 5mm Offset on Contour means that a virtual displacement is applied 
normal to the contour geometry. A 5mm Axial Part Offset means that a virtual 
displacement is applied to the part geometry along the tool axis direction.
Compare with thickness. 

one way Machining in which motion is always done in the same direction. Compare with zig zag.

P

part operation Links all the operations necessary for machining a part based on a unique part registration 
on a machine. The part operation links these operations with the associated fixture and set-
up entities.

PP instruction Instructions that control certain functions that are auxiliary to the tool-part relationship. 
They may be interpreted by a specific post processor.

PPR Process Product Resources.

R

retract macro Motion defined for retracting from the operation end point

S
safety plane A plane normal to the tool axis in which the tool tip can move or remain a clearance 

distance away from the workpiece, fixture or machine.

set up Describes how the part, stock and fixture are positioned on the machine.

spindle speed The angular speed of the machine spindle. 
Measured in linear or angular units (m/min or rev/min, for example).

stock Workpiece prior to machining by the operations of a part operation.

T



thickness Specifies a thickness of material to be removed by machining. A thickness value must be 
greater than zero and is measured normal to the machined geometry. For example, if a 
5mm Finish Thickness is specified on an operation then 5mm of material will be removed 
during the finish pass. 
Compare with offset.

tool axis Center line of the cutter.

tool change An auxiliary command in the program that corresponds to a change of tool.

tool clash Area where the tool collided with the workpiece during a rapid move.

tool path The trajectory that the tool follows during a machining operation.

total depth The total depth including breakthrough distance that is machined in a hole making 
operation.

turning plane Plane defined by two axes (called axial and radial) of a machining axis system.
Selected geometry must lie on the turning plane.
In the Lathe Machining product, the tool assembly is positioned according to axial and 
radial axes (usually ZX) as well as the origin of the machining axis system. This is not the 
case in the Multi-Slide Lathe Machining product. In this case there is one plane per turret.

U

undercut Area where the tool has left material behind on the workpiece.

Z

zig zag Machining in which motion is done alternately in one direction then the other.  Compare 
with one way.



Index 

                  

A
Add Local Information contextual command    

Add User Representation contextual command  

Analyze contextual command  
Angle of Incline 

Groove Finish Turning parameter  

Groove Turning parameter  

Ramp Recess Turning parameter  

Recess Turning parameter  

APT import  

APT source generation  
Attack Distance 

Groove Turning parameter  

Recess Turning parameter  

Rough Turning parameter  
Automatic mode 

Update Input Stock  

Automatic Stock Selection for Turning Operations contextual command   
Auxiliary operation 

COPY Operator  

Copy Transformation  

Machine Rotation  

Machining Axis Change  

PP Instruction  

Tool Change  

TRACUT Operator  
Axial Depth of Cut 

Recess Turning parameter  

Rough Turning parameter  
Axial Limit for Chuck Jaws 

Ramp Rough Turning parameter  

Rough Turning parameter  



Axial part offset 

Groove Finish Turning parameter  

Groove Turning parameter  

Profile Finish Turning parameter  

Recess Turning parameter  

Rough Turning parameter  

B
Browse Local Information contextual command  

By Curve contextual command         

C
CATProduct generation  
Change Output Point 

Groove Finish Turning parameter  

Groove Turning parameter  

Ramp Recess Turning parameter  

Recess Turning parameter  

Thread Turning parameter  
Chip Break 

Groove Turning parameter  

Clean Computed Stock Data contextual command  
Clearance on crest diameter 

Thread Turning parameter  

Clfile code generation  
command 

Edit Cycle  

Groove Turning  

Lathe Groove Finish Turning  

Profile Finish Turning  

Ramp Recess Turning  

Ramp Rough Turning  

Recess Turning  



Rough Turning  

Sequential Turning  

Thread Turning  

Update Input Stock   

Compute Stock and Tool Path contextual command  
contextual command 

Add Local Information    

Add User Representation  

Analyze  

Automatic Stock Selection for Turning Operations   

Browse Local Information  

By Curve         

Clean Computed Stock Data  

Compute Stock and Tool Path  

Copy Local Information  

Edit Local Information  

Edit NC Resources  

Paste Local Information  

Remove Input Stock   

Remove Local Information  

Save in Catalog  

Sectioning         

Update Computed Stock Status  

Update Input Stock  
Contouring for Outside Corners 

Groove Finish Turning parameter  

Profile Finish Turning parameter  

Copy Local Information contextual command  

COPY Operator  

Copy-Transformation Instruction  
Corner Processing 

Groove Finish Turning parameter  

Profile Finish Turning parameter  
CUTCOM 

Groove Finish Turning parameter  



Profile Finish Turning parameter  

D
Depth of cut 

Thread Turning parameter  

direct axis system  

direct machining axis system  

Documentation generation  

E
Edge Selection toolbar   

Edit Cycle command  

Edit Local Information contextual command  

Edit NC Resources contextual command  
End Limit 

Groove Finish Turning parameter  

Profile Finish Turning parameter  

Ramp Rough Turning parameter  

Rough Turning parameter  

Thread Turning parameter  
End Limit Offset 

Groove Finish Turning parameter  

Profile Finish Turning parameter  

Thread Turning parameter  
End limit offset 

Rough Turning parameter  
Entry Flank Angle 

Ramp Recess Turning parameter  

Ramp Rough Turning parameter  
Exit Flank Angle 

Ramp Recess Turning parameter  

External Groove Finish Turning  

External Groove Turning  



External Profile Finish Turning  

External Ramp Recess Turning  

External Ramp Rough Turning  

External Recess Turning  

External Rough Turning  

External Threading  

F
Face 

Ramp Rough Turning mode  

Rough Turning mode   

Face Ramp Rough Turning  

Face Rough Turning   
Feeds and Speeds 

Groove Finish Turning parameter  

Groove Turning parameter  

Profile Finish Turning parameter  

Ramp Recess Turning parameter  

Ramp Rough Turning parameter  

Recess Turning parameter  

Rough Turning parameter  

Sequential Turning parameter  
First passes 

Thread Turning parameter  
First Plunge 

Groove Turning parameter  
Flank Gouging Angle 

Ramp Recess Turning parameter  
Follow 

Sequential Turning motion  

Follow Tool Motion  

Frontal Groove Finish Turning  

Frontal Groove Turning  

Frontal Profile Finish Turning  



Frontal Ramp Recess Turning  

Frontal Ramp Rough Turning  

Frontal Recess Turning  

Frontal Rough Turning  

G
Go Delta 

Sequential Turning motion  

Go Delta Motion  
Go InDirv 

Sequential Turning motion  

Go InDirv Tool Motion  
Go Standard 

Sequential Turning motion  

Go Standard Tool Motion  
Gouging Safety Angle 

Groove Turning parameter  

Recess Turning parameter  

Groove Finish Turning operation   
Groove Finish Turning parameter 

Angle of Incline  

Axial part offset  

Change Output Point  

Contouring for Outside Corners  

Corner Processing  

CUTCOM  

End Limit  

End Limit Offset  

Feeds and Speeds  

Lead-in  

Lift-off  

Machining Direction  

Machining Tolerance  

Offset  
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